
What’s New for
Avid® Media Composer® v5.5

Avid Symphony™ v5.5
Avid NewsCutter® v9.5

New Features

The following lists what’s new for the current editor release.

Feature Description For More Info

Transition manipulation in 
the Timeline

You can modify transition effects in the 
Timeline without using the Quick Transition 
dialog box

See “Modifying Transition Effects 
in the Timeline” on page 6.

EUCON™ integration You can use Avid Artist Control, Avid Artist 
Transport, and Avid Artist Mix with your 
Avid editing application for audio navigation 
and transport functions, as well as some video 
and audio editing features such as recording 
automation gain.

The only Windows OS supported with the 
editing application and EUCON is Windows 
7 64-bit.

See “Using Avid Artist Series 
Controllers” on page 8.

Mbox family of audio 
devices (3rd Generation)

You can use the new version of the Avid 
Mbox family of audio devices — Mbox, 
Mbox Pro, and Mbox Mini — with supported 
configurations with your Avid editing 
application.

See “Using Mbox Family Audio 
Devices” on page 24 and 
“Co-installation Configurations 
and Audio Device Support” in the 
ReadMe.
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Support for AJA® Io 
Express™

The AJA Io Express is supported as an 
input/output device. It supports baseband 
video I/O with deck control and monitoring 
capabilities for Media Composer and 
NewsCutter. 

See “AJA Io Express Support” on 
page 27.
For information on installing the 
Io Express, see your AJA 
documentation and visit the 
www.aja.com site.

Pro Tools|Native HD 
support

You can install and run your Avid editing 
application with Pro Tools v9.0 Native and 
HD audio cards. Pro Tools HD is supported 
only on Macintosh systems.

See “Avid Pro Tools|HD Native 
Hardware Configuration for Avid 
Editing Systems” on page 29.

Import Multichannel Audio You can use the Import Settings dialog box to 
define the audio track formats for the audio 
channels in your imported media, up to a 
maximum of 16 audio channels for the clips 
in your bins. This allows you to specify 
which source channels are treated as mono or 
multichannel audio tracks in your project, 
rather than having to modify the clips in your 
bin after you import the source media.

See “Importing with Multichannel 
Audio” on page 33.

Exported locators import to 
Pro Tools as markers

When you export sequences with locators as 
AAF files, the locator information is 
included. An editor working on Pro Tools 
v9.0 or later can then choose to import the 
locators as Pro Tools as markers. The markers 
contain the same information as locators in 
your Avid editing system.

See “Suggested Uses for 
Locators” on page 36.

Multichannel mapping for 
Send to Playback

Using the Transfer Settings dialog box, you 
can now map any combination of audio tracks 
to any of the 16 available output channels 
when you send a sequence to playback using 
Interplay Transfer. The Send To Playback 
operation performs a mixdown on the 
selected tracks before the application sends 
the sequence to Interplay Transfer.

See “Mapping Audio Tracks to 
Output Channels” on page 37

AIR audio plug-ins Your Avid editing application now comes 
with a collection of Advanced Instrument 
Research (AIR) RTAS plug-ins.

See “AIR Avid Audio Plug-Ins” 
on page 42.

ICS support Avid editing applications now include 
Unicode support for file import/export 
operations.

See “International Character 
Support” on page 70.

Feature Description For More Info

http://www.aja.com/
http://www.aja.com/
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AMA Linking with 
Multichannel Audio

You can use the AMA Settings dialog box to 
define the audio track formats for the audio 
channels in your linked media, up to a 
maximum of 16 audio channels for the clips 
in your bins. This allows you to specify 
which source channels are treated as mono or 
multichannel audio tracks in your project, 
rather than having to modify the clips in your 
bin after you link to the AMA media.

See “AMA Linking with 
Multichannel Audio” on page 70.

AMA Plug-Ins The AMA Plug-Ins are unbundled from the 
Avid editor installers, with the exception of 
the AMA QuickTime plug-in.  This allows 
AMA plug-in updates to be released when 
needed without relying on an Avid editing 
release.

After you install your Avid editing 
application, be sure to go to 
www.avid.com/ama to download 
the latest AMA plug-ins that are 
qualified with your Avid editing 
application.
To see a list of AMA plug-ins 
installed on your system, select 
Tools > Console, and type: 
AMA_ListPlugins.

Sony XDCAM and 
HDCAM SR Lite AMA 
plug-ins

Avid AMA supports XDCAM optical and the 
new SxS memory-card based XDCAM 
cameras.

Avid AMA supports Sony HDCAM SR Lite 
media.

See the www.avid.com/ama 
website for information and the 
Sony release notes.

Panasonic P2 AMA Plug-in The Panasonic P2 AMA Plug-in supports P2 
compliant media that was created on an 
Edius® editing system.

See the www.avid.com/ama 
website for information.

Enhancements to the 
Illusion FX FluidMorph 
Effect

The FluidMorph effect now includes 
additional Source parameter options that 
expand your artistic choices for morphed 
transitions. Also, in previous versions of your 
Avid editing application, FluidMorph effects 
sometimes showed inconsistencies in image 
quality between the preview and rendered 
states of the effect. FluidMorph effects no 
longer have this limitation.

See “FluidMorph Effect Source 
and Input Parameters” on page 74.

Feature Description For More Info

http://www.avid.com/US/products/Avid-Media-Access
http://www.avid.com/US/products/Avid-Media-Access
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AVC-I Module for Nitris 
DX

This release supports a Nitris DX with AVC-I 
codec module. The codec module provides 
real-time encoding to the AVC-intra 
compression format, using the 10-bit high 
definition H.264 intra-frame codec.

For information on installing the 
AVC-I Module into a Nitris DX 
see the Avid Nitris® DX AVC-I 
Module Upgrade procedure 
supplied with your upgrade kit.

To see a video on how to install 
the codec module, go to 
http://avid.custkb.com/avid/app/se
lfservice/search.jsp?DocId=38025
3.

For information on AVC-I, see 
“Using the AVC-I Codec Module” 
on page 74.

PhraseFind PhraseFind allows you to search for audio 
dialogue throughout your bins within a single 
project. The PhraseFind feature is purchased 
separately.

If you are using PhraseFind in a shared 
storage environment, your ISIS client must be 
a minimum of v2.2.2 and MediaNet v3.3.0

See the Getting Started with 
PhraseFind guide supplied with 
the PhraseFind feature.

Text Find The current Find feature has been updated in 
a new window called Text Find. Text Find 
allows you to enter text and search bins, 
Scripts and the Timeline. 

See “Searching for a Clip or 
Sequence with Text Find” on 
page 75.

Avid License Control tool A tool that allows you to activate and 
deactivate ScriptSync and PhraseFind. If you 
purchased and then install these options for 
your Avid editing application, the Avid 
License Control tool opens automatically and 
takes you through the activation of these 
options.

See the “Installing and 
Activating” chapter in the Getting 
Started with PhraseFind or 
Getting Started with ScriptSync 
booklet for more information. 

H.264 support H.264 proxy media generated by AirSpeed 
Multi Stream or Interplay Transcode is 
supported in the editing application in an 
Avid Interplay environment.

See the topic “H.264 End-to-End 
MultiRez Workflow” in the Avid 
Interplay Best Practices.

Feature Description For More Info

http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=380253
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AMA QuickTime Source 
Setting 

This option allows you to change the dynamic 
range of a linked AMA QuickTime movie 
from 601/709 video range (16-235) to RGB 
range (0-255) or from RGB range (0-255) to 
601/709 video range (16-235). This setting is 
only supported with QuickTime movies that 
were created with a non-Avid codec, 
including ProRes, H.264, and Animation.

For more information, see 
“Adjusting QuickTime Source 
Settings” on page 78.

Updated Co-installation 
information

You can install your Avid editing application 
with the new versions of Pro Tools hardware 
and peripherals, including the Native and HD 
cards.

See “Co-installation 
Configurations and Audio Device 
Support” in the ReadMe.

Change to Audio Driver 
installation

If you use any Pro Tools® audio devices — 
for example, any of the Avid Mbox® family of 
devices or the Avid Pro Tools|HD Native 
hardware — you must install the device 
drivers separately. Avid audio device drivers 
are located in the following directory:

(Windows) Program 
Files\Avid\Utilities\AudioDriverInstallers

(Macintosh®) Applications\Utilities\Avid 
Utilities\Avid Audio Drivers

Matrox MX02 Mini With the new Matrox MX02 Mini drivers, the 
720p23.976 and NTSC 23.976 Project Types 
are supported. See the www.matrox.com 
website for information on the latest drivers 
supported with the Avid editing applications.

With the new Matrox drivers you can output 
PSF or true progressive from the editing 
application. The default is PSF. 
(Windows) Control the output through the 
Video Output Tool.
(Macintosh) Control the output with the 
Console Command -togglepsf [true, false].

See “Setting up the Matrox MX02 
Mini” in the Help.

Fast Scrub for Software 
only systems.

In previous releases, Fast Scrub was available 
on systems with Avid Nitris DX and Avid 
Mojo DX hardware. This option is now 
available when using Software only systems.

See “Timeline Settings” in the 
Help for information on Fast 
Scrub.

Feature Description For More Info
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Modifying Transition Effects in the Timeline

If you use the Transition Manipulation button in the Smart tool, you can edit transition 
effects by dragging the transition handles or by moving the transition effect icon. When you 
position your mouse pointer over a transition effect, the pointer changes to either a resizing 
arrow or a hand icon, which allows you to lengthen or shorten the transition by dragging to 
the left or right, or to move the transition by dragging the effect icon to another position in 
the Timeline.

Modifying a transition effect by dragging in the Timeline allows you to do the following, 
depending on the position of the transition effect:

• Dragging a transition handle away from or towards the cut point increases or decreases 
the duration of the transition in that direction.

• If you want to modify the duration of the transition equally in both directions (on the 
incoming and outgoing sides of the transition), you can press the Alt key (Windows) or 
the Option key (Macintosh) before dragging a transition handle. Similarly, dragging 
toward the transition decreases the duration of the effect in both directions.

• You cannot move a transition effect or drag a transition handle beyond the cut point 
itself.

• If you enable link selection or if you select more than one transition, you can modify 
transitions on multiple clips at the same time. If the transitions on the clips differ in the 
length of the effect or the duration of the available handles, you cannot lengthen the 
transitions beyond the limit of the shortest handle or beyond a cut point on any of the 
selected tracks. (For more information on editing with linked clips, see “Linked Clips” 
in the Help.)

To lengthen or shorten the duration of a transition effect in the Timeline:

1. Click the Transition Manipulation button in the Smart tool.

2. Position the mouse pointer over the transition handle on either the outgoing or incoming 
side of the transition.

The pointer changes to a resizing arrow.

3. Do one of the following:
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t To lengthen the duration of a transition, drag the transition handle away from the 
effect icon in the center. You can press the Alt key (Windows) or the Option key 
(Macintosh) before you drag a transition handle to lengthen the duration of a 
transition equally in both directions.

t To shorten the duration of a transition, drag the transition handle toward the effect 
icon in the center. You can press the Alt key (Windows) or the Option key 
(Macintosh) before you drag a transition handle to shorten the duration of a 
transition equally in both directions.

The duration of the transition changes as you drag the transition handle. If you enable 
link selection, the duration of the transition in the Timeline changes for all linked clips.

The monitor display changes to a Transition Corner display, showing you six frames 
that you can use as reference points when trimming a transition effect.

To adjust the position of the effect in the Timeline:

1. Click the Transition Manipulation button in the Smart tool.

2. Position the mouse pointer over the effect icon for the transition you want to move.

The pointer changes to a hand.

3. Drag the effect to adjust its position with respect to the cut point.

The Timeline updates to show the new effect position. If you enable link selection, the 
transition moves on all tracks in the Timeline with linked clips.

The monitor display changes to a Transition Corner display, showing you six frames 
that you can use as reference points when trimming a transition effect.

n You cannot drag an effect beyond the ends of the handles on the media because you cannot 
create a transition unless both incoming and outgoing media are available for every frame 
of the transition. You also cannot drag an effect beyond the cut point.
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Using Avid Artist Series Controllers
This section includes topics that provide information on configuring and using the Avid 
Artist Series controllers with your Avid editing application: Avid Artist Control, Avid Artist 
Transport, and Avid Artist Mix. These controllers employ the EUCON™ (Extended User 
Control) protocol, which allows for integrated control of your Avid editing application and 
EUCON-compatible devices. You can use the controllers with your Avid editing application 
to perform audio navigation and transport functions, as well as some video and audio editing 
features such as recording automation gain.

• Installing EuControl Software

• Configuring Avid Artist Series Controller Settings

• Configuring EuControl Settings

• Artist Series Controller Button Mappings

• Customizing Avid Artist Series Controls

• Moving Through Footage with Artist Series Controllers

• Automation Gain and Pan on Artist Series Controllers

• Recording Automation Gain and Pan with Artist Series Controllers

• Using the Latch Mode Feature on Artist Series Controllers

Installing EuControl Software

The EuControl application controls your Artist Series controller and communicates with 
your Avid editing application. You must install EuControl before you use any Artist Series 
controller.

If you want to connect your Artist Series controller to an Avid editing system that is part of 
an Avid ISIS shared storage environment, the following requirements apply:

• (Macintosh only) Avid recommends that you connect your Artist Series controller to the 
built-in Ethernet 1 port on your Macintosh system. If you have limits to the number of 
Ethernet connections you use — for a corporate network or for shared storage — you 
might need to set the service order for your Artist Series controller to a lower priority 
than your other Ethernet connection. For more information on configuring your Ethernet 
connections, see “Configuring Ethernet Connections (Macintosh)” on page 10. You can 
change port assignments in the EuControl Settings application if necessary.

• Avid also recommends that you disable the network interface you use for your Artist 
Series controller in the ISIS Client Manager preferences. This prevents ISIS from trying 
to use the Ethernet port assigned to EUCON for your shared storage operations. For 
more information, see the Avid ISIS Client Guide that came with your ISIS product.
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• Avid ISIS supports dual Ethernet connections to maximize bandwidth use and increase 
performance. Since your Artist Series controller must use one Ethernet port to connect 
to your Avid editing system, Avid does not support dual connection on Macintosh 
systems connected to an ISIS switch.

• Artist Series controllers do not support connection through a third-party Ethernet card.

To install EuControl:

1. Do one of the following:

t If you downloaded the latest software from the Avid Web site, double-click the 
installer.

t Insert the installation CD into your system, and double-click the installer.

2. Follow the on-screen instructions to install the software.

n Download the most current version of EuControl if prompted to do so during installation.

When installation completes, EuControl launches automatically.

3. You should check for updated firmware for your Artist Series controller by doing the 
following:

a. Do one of the following:

t (Windows) Double-click the EUCON icon in the notification area.

t (Macintosh) Click the EUCON icon in the dock, and then select Window > 
EuControl Settings.

The EuControl Settings dialog box opens.

b. Click the Surfaces tab, and then click Update Firmware.

If there is updated firmware for your Artist Series controller, EuControl 
automatically downloads it.

c. Follow the on-screen instructions to install the new firmware.

4. Shut down your system.

5. Connect your Artist Series controller. For information on setting up your Artist Series 
controller, see the documentation that came with your equipment.

Configuring Avid Artist Series Controller Settings

You use the Controller Settings dialog box to configure your Avid editing application so that 
it can communicate with your Artist Series controllers. 
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To configure your Avid editing application for an Artist Series controller:

1. Double-click Controller Settings in the Settings list of the Project window.

The Controller Settings dialog box opens.

2. Select Controller > EUCON Controller.

3. Click OK.

Configuring Ethernet Connections (Macintosh)

You can connect your Artist Series controller to either the Ethernet 1 or Ethernet 2 port on 
your Macintosh system. By default, the EuControl application is configured to use 
Ethernet 1. You might need to change this configuration if your system connects to a 
corporate network or if it is part of a shared storage environment — for example, if you 
connect your Macintosh system to an Avid ISIS system.

The following procedure describes how to configure your network connections if you need 
to reserve one Ethernet port for a network or shared storage connection. You can use either 
Ethernet port for your Artist Series controller, but you should set the network priority for 
your network or storage connection higher than the priority for your Artist Series controller.

To configure Ethernet ports on a Macintosh system:

1. Connect your Artist Series controller to either the Ethernet 1 or Ethernet 2 port on your 
Macintosh system.

2. Select the Apple menu > System Preferences.

3. In the Other area, click Euphonix.

The Euphonix dialog box opens.
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4. Click the Network Interfaces menu and select either Ethernet 1 or Ethernet 2, depending 
on which Ethernet port you want to use for your Artist Series controller.

5. Close the Euphonix dialog box.

6. Select the Apple menu > System Preferences.

7. In the Internet & Wireless area, click Network.

The Network dialog box opens.

8. Click the Action menu and select Set Service Order.

The Service Order dialog box opens.

9. If the Ethernet connection you want to use for your corporate network or shared storage 
connection is not at the top of the network connections list, select that Ethernet 
connection and drag it to the top of the list. For more information on setting the service 
order, see the Apple Help for your Macintosh system.

10. Click Apply, and then close the Network dialog box.

Configuring EuControl Settings

Before you can use an Artist Series controller with your Avid editing application, you must 
configure the EuControl settings. You can connect your Artist Series controller to the 
EuControl application on your system so you can use it as a controller, connect additional 
workstations so they can access the controllers, and assign functions to buttons and keys on 
the Artist Series controller.
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The EuControl application starts when you start your computer and runs in the background. 
Avid recommends that you make sure EuControl is running before you start your Avid 
editing application.

For a full description of configuration procedures and options, see the documentation that 
came with your Artist Series controller.

To connect an Artist Series controller to your system:

1. Start your Avid editing application.

2. Do one of the following:

t (Windows) Double-click the EUCON icon in the notification area.

t (Macintosh) Click the EUCON icon in the dock, and then select Window > 
EuControl Settings.

EuControl Settings application opens. The All Surfaces list displays all available Artist 
Series controllers.

3. Click the Automatically add: menu, and select one of the following:

t To add all controllers listed in the All Surfaces list — which lists all devices 
available on your subnet — select All Surfaces. This setting is useful when you are 
the only person running EuControl on your network.

t To add only those controllers listed in the My Surfaces, select My Surfaces Only. 
Since only one user at a time can control a surface, this avoids claiming surfaces 
needed by other users on your network.
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The selected devices are connected to EuControl.

4. (Option) If you select My Surfaces Only and you want to specify additional controllers 
to connect to your EuControl application, select a controller in the All Surfaces list, and 
then click Add.

The controller appears in the My Surfaces list. You can rearrange the order of the 
controllers using the up and down arrows, and you can remove controllers from the list 
using the Remove button. You can also rename the controller, which allows you to easily 
identify multiple controllers in the My Surfaces list.

5. Click the Workstation tab.

The Workstations tab opens. The All Workstations list displays all systems on your 
subnet that have been configured for access to the available Artist Series controllers.

6. (Option) If you want more than one workstation to access your Artist Series controllers, 
do the following:

a. Select the workstation in the All Workstations list and click Add.

b. Select the workstation in the My Workstations list and click Attach.

A check mark appears in the Attached column in the My Workstations list. The 
workstation can now access the Artist Series controllers connected to EuControl.

7. Close the EuControl Settings application.
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Artist Series Controller Button Mappings

When EuControl opens for the first time, it includes a set of default Avid editing functions 
mapped to the Artist Series controller buttons. To modify the button mappings, see 
“Customizing Avid Artist Series Controls” on page 15.

The Soft Keys tab controls Surface, Wheel, and Touchscreen soft key assignments. With 
Artist Series controllers that include a Touchscreen, you can access the Surface soft keys 
with the circular buttons below the Touchscreen, and you can access the Touchscreen soft 
keys with the Soft Keys Setup Touchscreen.

n The mappings included in the Soft Keys tab apply only to Artist Control and Artist Transport.

Artist Control and Artist Transport can control multiple applications, each with its own soft 
key assignments. Since the EuControl application responds dynamically as you move 
between applications, soft key assignments might change in the Soft Keys tab as the active 
application changes. Changing the focus to the desired application and then to the EuControl 
application restores the current assignments. You can save your soft key assignments at any 
time while using EUCON.

n  Be sure to check that the proper application is active before you click Save, Restore, or 
Revert.

The Soft Keys tab displays the name of the active application above the option menus and 
the soft key assignments.
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EuControl Settings: active application, option menus, soft key display buttons

The default EuControl button mappings include the following:

• Surface — The Surface keys control the functions assigned to the 12 buttons located 
below the Touchscreen on Artist Control. The Surface section organizes the buttons in 
6 pages. You can click the Page menu to select a different set of commands.

• Touchscreen — The Touchscreen keys control the keys displayed on the Soft Keys 
Setup Touchscreen on Artist Control. The Touchscreen section organizes the buttons in 
6 pages.

• Wheel — The Wheel keys control the keys displayed above the Jog and Shuttle wheels 
on the Artist Control and Artist Transport.

Customizing Avid Artist Series Controls

You can modify the default Soft Key functions of the controls on your Artist Series 
controller by mapping them to buttons and keyboard shortcuts in your Avid editing 
application. You can also add custom key sequences, EUCON commands, pages to the 
surface controls or the touchscreen, and jog and shuttle wheel functions for some devices.

The following procedure provides a generic description of how to customize your controller. 
For a full description of the customizations available, see the documentation that came with 
your Artist Series controller.
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To change a function in the Artist Series controls:

1. In the EuControl application, click the Soft Keys tab.

2. Click the Section menu, and select one of the following:

- Surface

- Touchscreen

- Numpad

- Softkeys

- Wheel

The Soft Keys tab displays the existing controls for the selected section.

The Artist Transport controls for the Touchscreen.

3. Do one of the following:

t Select a button whose function you want to customize, and click Command.

t Double-click a button whose function you want to customize.

The Soft Key Command Editor opens.
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4. Specify the action you want to associate with the control button.

The Soft Key Command Editor organizes the default commands as they appear in the 
Command palette or in menus.

5. Close the Soft Key Command Editor.

The Soft Key tab updates and displays the new function.

6. Click Save.

7. Close the EuControl Settings application.

To add a function to the Artist Series controls:

1. In the EuControl application, click the Soft Keys tab.

2. Click the Section menu, and select one of the following:

- Surface

- Touchscreen

- Numpad

- Softkeys

- Wheel

The Soft Keys tab displays the existing controls for the selected section.
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The Artist Transport controls for the Touchscreen.

3. If the display does not include any blank keys, click the Page menu and select a new 
page. You can also click the Add button to add a new page.

4. Do one of the following:

t Select a blank key and click Command.

t Double-click a blank key.

The Soft Key Command Editor dialog opens.

5. Click Add and select one of the following:

- Key
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- EuCon

- Page

- MC

- Wheel

6. In the Details column, select the function you want to associate with the new soft key.

EUCON commands automatically label the button but do not select an icon.

7. Close the Soft Key Command Editor.

The Soft Key tab updates and displays the new function.

Moving Through Footage with Artist Series Controllers

You can use your Artist Series controller to control how you move through footage. 
Depending on the functions available on your controller and the default and customizable 
controls, you can use the following methods:

• The Jog wheel allows for frame-by-frame positioning, depending on how fast you turn 
the wheel right (clockwise) or left (counterclockwise). Use the Jog wheel when you 
want to locate a specific frame by slowly viewing footage.

• The Shuttle ring alters the speed of playback by how far you turn the ring. The more you 
turn the ring to the right, the faster the footage moves forward. To move the footage in 
reverse, turn the ring to the left of the midpoint position. When held in position, footage 
continues to moves at a fixed rate. When you release the Shuttle ring, it automatically 
returns to its center position and footage stops changing. Use the Shuttle ring when you 
want to quickly scan footage.

• The Transport Controls allow you to play, pause, rewind, and fast forward in your 
sequence.

• You can use the Rewind, Pause, and Fast Forward keys on your Artist Series controller 
to move through your footage as you do with J-K-L play in your Avid editing 
application. For more information on using the J-K-L keys, see “Playing Footage with 
the J-K-L Keys (Three-Button Play)” in the Help“Playing Footage with the J-K-L Keys 
(Three-Button Play)” in the Help.

• The track selection buttons on your Artist Series controller allow you to select and 
deselect tracks in the Timeline. Selecting tracks in the Timeline or in the Audio Mixer 
tool updates the track selection display in your Artist Series controller.

• You can solo and mute tracks on your Artist Series controller to isolate tracks as you 
monitor the audio playback. Using the solo and mute buttons on your Artist Series 
controller automatically updates the display in the Track Control panel and the Audio 
Mixer tool in your Avid editing application. You can use these buttons during playback.



  

20

For more information on moving through footage, see the documentation that came with 
your Artist Series controller.

Automation Gain and Pan on Artist Series Controllers

Some Artist Series controllers provide fader strips, each with a touch-sensitive fader, that 
control audio tracks for recording gain. Faders control assigned tracks and reflect changes 
made in the audio track properties, such as automation gain. Some Artist Series controllers 
also provide pan soft knobs that control audio tracks for recording pan automation. Pan soft 
knobs control assigned tracks and reflect changes made in the audio track pan values.

You can use the features available in the Audio Mixer tool to gang faders on the Artist Series 
controller. When the faders for two or more tracks are ganged, the fader sends identical 
volume or pan messages for the tracks when you move one fader. This can be useful when 
you want to adjust audio on multiple tracks.

For information on ganging faders, see “Adjusting Clip Gain and Pan for Audio Tracks” in 
the Help.

Some Artist Series controllers include an On key, which indicates that a specified track is 
unmuted. Deselecting the On key mutes the track and changes the Mute button in your Avid 
editing application to orange for the specified track.

n A second On button is located next to the faders on Artist Mix controllers. This button 
currently is not used.

You can also use the Bank and Nudge keys available on some Artist Series controllers to 
change the track assignments of the faders on the controller if the number of tracks you want 
to automate gain or pan on exceeds the number of faders on the controller. The Bank button 
changes track assignments by the number of available faders — for example, shifting 
assignments from tracks 1 – 8 to tracks 9 – 16. The Nudge button changes track assignments 
by one track — for example, shifting assignments from tracks 1 – 8 to tracks 2 – 9.

Artist Mix provides buttons and indicator lights mapped to standard audio editing functions:

Button Function

SEL Controls and indicates automation pan recording.

SOLO Controls and indicates when a track is set to solo.

ON Controls and indicates when a track is unmuted or muted. The indicator is on 
when the track is not muted.
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Once you record your gain or pan automation, you can use the Artist Mix or the Artist 
Control to modify gain or pan values on any audio keyframe selected in the Timeline.

n You can disable the faders on your controller by pressing the Shift button and then pressing 
the Solo button on the left of the control surface. You might find this useful when you do not 
need to use the faders and you switch between the Source and Record monitors or the Source 
and Record views in the Timeline. To enable the faders, press the Shift button and the Solo 
button again.

Recording Automation Gain and Pan with Artist Series Controllers

If you record your automation in unlatched mode, releasing the fader returns the gain or pan 
values to the original values of the audio in your sequence. For information on enabling latch 
mode, see “Using the Latch Mode Feature on Artist Series Controllers” on page 22.

To record automation gain and pan information using an Artist Series controller:

1. Select Tools > Audio Mixer.

The Audio Mixer tool opens.

2. (Optional) Click the Audio Mixer mode button and cycle through the Audio Mixer 
mode settings to the mode you want to select.

3. Attach the Artist Series controller to your system. (See “Configuring Avid Artist Series 
Controller Settings” on page 9.)

The position indicator lights in the Audio Mixer tool change to blue when the fader 
controller or mixer is on and correctly attached to the system.

Position indicator lights 

4. Click the Timeline Fast Menu button and select Audio Data > Auto Gain or Audio 
Data > Audio Pan.

REC N Controls and indicates automation gain recording. The track display 
indicates the automation state by either an R (Read) or a W (Write).

Shift + REC N Controls and indicates automation mode. The current mode is not indicated.

SEL Y Controls and indicates if a track is selected or deselected.

Button Function
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5. Move the blue position indicator to the section of audio that you want to adjust and mark 
In to Out points.

6. Set Preroll and Postroll values, if necessary.

7. Click the Record button to start recording your actions.

8. Listen to the audio and adjust the slider or the pan control on the Artist Series controller 
for the track.

The system displays the slider values for the corresponding track in the Audio Mixer 
tool as you adjust the gain or pan.

9. Click the Record button again to stop recording.

10. Click the Audio Loop Play button to play the clip and test your results.

11. To decrease the number of keyframes, click the Audio Mixer Tool Fast Menu button, 
and select Filter Automation Gain on Track — In/Out or Filter Automation Pan on 
Track — In/Out. (Click the Track Selection button for a track to enable Filter 
Automation.)

12. (Option) If you delete too many keyframes, use the Undo command to restore them.

13. Repeat step 11 until you have decreased the number of keyframes to an acceptable level.

You should remove as many excess keyframes as possible while still maintaining the 
pan or gain changes. 

To change the tracks assigned to faders on the Artist Series controller, do one of the 
following:

t To move the track assignments to the left or right by the number of available faders, 
click the Bank Left or Bank Right button.

t To move the track assignments to the left or right by one track, click the Nudge Left or 
Nudge Right button.

Using the Latch Mode Feature on Artist Series Controllers

Some Artist Series controllers have an Auto REC button for each track that lets you enable 
or disable latch mode for recording automation gain and pan information. 

When a track is not in latch mode, it automatically stops recording as soon as you release it. 
When you release the fader, it begins moving again as it follows the volume information in 
the Timeline.

If you enable latch mode, gain and pan values remain at the last values set during your 
recording session.
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To use latch mode:

1. Click the Auto REC button for the appropriate tracks on the controller.

You can click the button before or during a recording session. 

2. Set In and Out points, and click the Record button in the Audio Mixer tool.

The system begins playing the section and the faders move accordingly.

3. When you want to make an adjustment, move the fader or pan soft knob to change the 
volume.

The system immediately begins recording.

4. When you are finished adjusting the section, release the fader or pan soft knob.

The system stops recording (but keeps playing) and the fader or soft knob snaps back to 
the level in the Timeline.

When the track is in latch mode, the system continues to record audio volume 
information after you release the fader or soft knob. 

5. (Option) Press the Auto REC button to stop recording and snap the button back to its 
current Timeline position.

Using the Artist Series Controller for Editing Media

You can use your Artist Series controller to perform some of the basic editing functions 
available in your Avid editing application, including the following:

• Mark In and Out points

• Splice in and Overwrite edits

• Lift and Extract edits

• Trim edits

• Multicamera edits

These functions allow you to edit and trim clips in your sequences using the controller rather 
than the buttons and tools in your Avid editing application. For example, you can use the Jog 
wheel to navigate to a transition in the Timeline, and then you can use the Soft Key functions 
to activate Trim mode, and then perform a single- or dual-roller trim. 

Some editing functions are mapped to your Artist Series controller by default. If you want to 
access other editing functions, you can customize the controls by mapping other functions to 
the soft keys or Touchscreen on your controller. For more information, see “Customizing 
Avid Artist Series Controls” on page 15.
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Using Mbox Family Audio Devices
You can use the Mbox® family of audio input/output hardware as external audio devices for 
your Avid editing application. This means you can use the Mbox devices to record source 
audio and to monitor output audio.

When you attach the Mbox device to your Avid editing system, all of its audio input and 
output connections are live. If you use a video input/output hardware device, you can use a 
an Mbox device with either a USB or an IEEE 1394 (FireWire) connection if you select the 
DNA/1394 button in the Timeline top toolbar. (For more information on using an 
input/output device with a 1394 connection, see “Selecting a DV Device” in the Help.) The 
Mbox device and the video I/O device remain as two separate audio sub-systems. They are 
not combined to increase the number of available audio channels. For audio input/output, the 
system creates a list of input options based on the audio devices that are present — for 
example, Mbox Mic/Line, Mbox S/PDIF, or Host 1394.

The following table lists some of the features of the Mbox 2 and the Mbox (3rd Generation) 
family of audio devices.

Mbox (3rd Generation) devices support audio sample rates up to 96 KHz. For a full 
description of MBox specifications, see the documentation that came with your device.

For a list of currently supported Mbox devices, see the ReadMe for your Avid editing 
application.

Device Connection Type Input/Output Types

Mbox 2 USB Analog, S/PDIF, MIDI

Mbox 2 Pro 1394 Analog, S/PDIF, MIDI, Word Clock In

Mbox 2 Mini USB Analog

Mbox 2 Micro USB Analog (monitor audio only; no input/output available)

Mbox (3rd 
Generation)

USB Analog, S/PDIF, MIDI

Mbox Pro (3rd 
Generation)

1394 Analog, S/PDIF, MIDI, Word Clock In

Mbox Mini (3rd 
Generation)

USB Analog
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Configuring the Mbox Device

You must start the Mbox device before you start your Avid editing application. If you start 
your Avid editing application when the audio device is turned off, you must exit your Avid 
editing application, turn the device on, and then start your Avid editing application.

n (Macintosh only) S/PDIF inputs appear in the Capture tool as Tracks 3-4.

To select the Mbox device in the Audio Project Settings dialog box.

1. Connect the Mbox device to your Avid editing system.

2. Start your Avid editing application.

3. Click the Settings tab in the Project window.

4. Double-click Audio Project Settings.

The Audio Project Settings dialog box opens.

5. Click the Hardware tab.

6. Click the Peripheral menu, and then select your Mbox device.

7. Close the Audio Project Settings dialog box.

Once you configure the Mbox device, you can select the audio input interface in the 
Capture tool and the Audio Punch-in tool. For more information, see “Preparing to 
Capture Audio” in the Help and “Recording Voice-Over Narration” in the Help.
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You can also use your device to monitor output audio by connecting headphones or 
speakers to the Mbox device.

Setting Up the Mbox Pro for Passthrough Monitoring (Windows Only)

If you use the Mbox Pro to monitor source audio, you must set the source for your 
headphone output in the Mbox Pro Control Panel to Stereo Mix 1. This allows you to 
monitor audio with your Avid editing application using the Passthrough Mix tool. 

To set your Mbox Pro to monitor passthrough audio:

1. Make sure your Avid editing application is not running.

2. Click the Start button, and select Control Panel.

3. Do one of the following:

t (Windows 7) If the View by menu is set to Category, click Hardware and Sound, 
and then click Avid Mbox Pro.

t (Windows 7) If the View by menu is set to Large icons or to Small icons, click Avid 
Mbox Pro.

t (Windows XP) Click Avid Mbox Pro.

The Mbox Pro Control Panel opens.
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4. Select your headphone output, and then click the Audio Source menu and select Stereo 
Mix 1.

5. Close the Mbox Pro Control Panel.

AJA Io Express Support

The Avid Media Composer and Avid NewsCutter editing applications have been qualified 
for use with the AJA Io Express input/output device.

Note the following when working with the editing application and the AJA Io Express:

• Ancillary data capture is not supported.

• The AJA Io Express supports 8 channels of embedded audio for SDI.

• The editing application does not support LTC with the AJA Io Express.

• Audio Punch-In is not supported.

• DVCPRO HD output for Digital Cut is not supported.

• Surround sound is not supported.

• The only Sample Rate option is 48kHz in the Audio Project Settings when an AJA 
Io Express is connected to your system.

• Avid does not support the serial port on the Io Express. You must use the Avid-qualified 
host-based RS-422 adaptor for serial deck control.

• OHCI (Host 1394) capture is not supported when you have an AJA Io Express 
connected. If you want to capture OHCI see “Capturing OHCI (Host 1394)” on page 28.

The following are supported with the AJA Io Express: 

AVC-Intra, AVCHD, Avid DNxHD, Canon XF, DV, DV25, DV50, DVCAM, DVCPRO, 
DVCPRO HD, GFCAM, HD-RGB, HDV, NTSC, P2, PAL, QuickTime, RED, Stereoscopic 
(via Metafuze), uncompressed SD, uncompressed HD, VC-1, XDCAM, XDCAM EX, 
XDCAM HD.

To ensure you are ready to work with the AJA Io Express, perform the following:

1. Check the Avid Media Composer or Avid NewsCutter editing application ReadMe to 
make sure your computer system or laptop has been qualified for use with the AJA 
Io Express. See the “Supported Hardware” topic.

2. Install the AJA Io Express software and hardware.The AJA Io Express attaches to the 
editing application computer via a PCIe adaptor (desktop) or an ExpressCard (laptop). 
These adaptors ship with AJA Io Express. See the AJA documentation and the 
www.aja.com website for installation information.
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3. Start your Avid editing application and set your applicable input settings. 

4. Set your applicable output settings:

n The options that appear in the Video Input tool and Video Output tool are those available 
when an AJA Io Express is attached.

Capturing OHCI (Host 1394)

With the Avid editing application, you cannot capture OHCI when connected to the AJA 
device. Perform the following if you want to capture OHCI.

To capture OHCI

1. Exit your editing application.

2. Shutdown your computer.

3. Turn off you AJA device.

Option Description

Input menu Defines the video input. You can select Host-1394, SDI, or HDMI. 

Settings menu Lets you save the settings for an individual tape each time you calibrate 
bars.

Option Description

Sync Lock Locks your output connection to the reference or an internal signal on the 
Avid input/output hardware. 

• Internal

• Reference

HDMI Out • HD

Downconvert Defines how downconverted SD video is resized. The options are 
Anamorphic, Letterbox, Center Cut, or OFF.

Component Format Lets you set your Component output to standard definition (SD 
Interlaced) or high definition.

Test Patterns Lets you choose a test pattern for calibrating during output.

Settings menu Lets you save the settings for an individual tape each time you calibrate 
bars.
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4. Restart your computer.

5. Launch the editing application. 

You can now capture OHCI.

Avid Pro Tools|HD Native Hardware Configuration 
for Avid Editing Systems

Avid Pro Tools v8.5 and later supports Native audio hardware, and Pro Tools v9.0 supports 
both Native and HD hardware. If you install your Avid editing application on a system with 
Pro Tools|HD Native, you can use the same audio hardware for both applications. The Avid 
editing application installs the necessary audio drivers.

Not all version of Avid editing applications are compatible with Pro Tools|HD Native 
hardware. For up-to-date information on co-installation and supported configurations, see 
the ReadMe for your Avid editing application.

If you use Avid Adrenaline, Avid Mojo SDI, or Matrox MX02 Mini hardware in DNA 
mode, or if you have Avid DX hardware installed with your system, you cannot access the 
Pro Tools|HD Native hardware. You can use the Pro Tools|HD Native hardware in a 
software-only Avid editing system or with supported Avid hardware in 1394 mode.

n Pro Tools|HD Native audio hardware is supported only in some co-installation 
configurations, and for Pro Tools v9.0 the HD hardware is supported only on Macintosh 
systems and 32-bit Windows systems. For more information about co-installation, see the 
ReadMe documentation that came with your Avid editing application.

With Pro Tools|HD Native hardware installed on a supported Avid editing system, you can 
perform the following:

• Play back audio through up to 8 audio outputs. You can also play back audio with a 
SYNC HD or SYNC I/O device connected. The Avid editing application does not 
control the clock settings for these devices.

• If you have multiple audio interfaces connected (“daisy-chained”) to your HD or Native 
card, the playback defaults to outputs 1 and 2 of the first device.

• The Avid editing application can input and output audio up to 48 kHz with HD or Native 
hardware.

To set up your system to use the HD or Native hardware with your Avid editing application, 
see the following topics:

• “Configuring the ASIO Driver (Windows)” on page 30

• “Configuring the CoreAudio Driver (Macintosh)” on page 32



  

30

Configuring the ASIO Driver (Windows)

You can configure the ASIO driver settings by using the ASIO Control Panel, which you 
access from the Audio Project Settings dialog box.

To configure the ASIO driver:

1. In the Avid editing application, click the Settings tab in the Project window.

2. Double-click Audio Project in the Settings list.

The Audio Project Settings dialog box opens.

3. Click the Hardware tab.

4. Click Edit.

The ASIO Control Panel opens.
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5. (Optional) Click the Buffer Size menu and select a buffer size.

Generally, smaller buffer sizes are preferable. However, if you experience any problems 
with performance (such as clicks and pops during recording or playback), try increasing 
the Buffer Size setting.

6. Click the Device menu and select the audio device connected to your HD or Native 
hardware.

7. Click Advanced.

The Hardware Setup dialog box opens.

8. Select the options you want for your audio input/output operations. For more 
information on the settings in the Hardware Setup dialog box, see “Configuring Your 
Pro Tools|HD Native System” in the Pro Tools|HD Native User Guide that came with 
your Pro Tools system.

Your Avid editing application uses only 8 channels of audio output. Also, the 
application controls the audio sample rate, not your HD or Native hardware.

9. Click OK to close the Hardware Setup dialog box.

10. Click OK to close the ASIO Control Panel.

Once you configure the audio device, you can use your device to monitor output audio 
by connecting headphones or speakers to the audio device.

11. Close the Audio Project Settings dialog box.
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Configuring the CoreAudio Driver (Macintosh)

You can configure the CoreAudio driver using CoreAudio Manager. The CoreAudio 
Manager application launches automatically the first time your Avid editing application 
accesses the CoreAudio driver — for example, the first time you play audio on a system with 
an HD or Native card installed. If the CoreAudio Manager icon is hidden when first 
launched, click the icon in the dock. 

Use CoreAudio Manager to change the CoreAudio Buffer Size setting and control volume 
and mute for the CoreAudio Driver. CoreAudio Manager also identifies your audio 
hardware, the supported number of input and output channels and the number of attached 
clients (applications).

To configure the CoreAudio driver:

1. Do one of the following:

t If your Avid editing application is running and you have an audio sequence loaded 
in the Source/Record monitor, click Play and then click the CoreAudio Manager 
icon in the dock.

t Double-click the CoreAudio Manager file (located in /Applications/Digidesign/).

The CoreAudio Manager opens.

2. (Optional) Click the Buffer Size menu and select a buffer size.

Generally, smaller buffer sizes are preferable. However, if you experience any problems 
with performance (such as clicks and pops during recording or playback), try increasing 
the CoreAudio Buffer Size setting. You can also change the buffer size from within the 
Avid editing application if it is the only client attached to the CoreAudio Driver. 

3. Click HW Setup.

The Hardware Setup dialog box opens.
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4. Select the options you want for your audio input/output operations. For more 
information on the settings in the Hardware Setup dialog box, see “Configuring Your 
Pro Tools|HD Native System” in the Pro Tools|HD Native User Guide that came with 
your Pro Tools system.

Your Avid editing application uses only 8 channels of audio output. Also, the 
application controls the audio sample rate, not your HD or Native hardware.

5. Click OK to close the Hardware Setup dialog box.

Once you configure the audio device, you can use your device to monitor output audio 
by connecting headphones or speakers to the audio device.

6. If your Avid editing application is not running, you can click Quit to close the 
CoreAudio Manager.

c If the Avid editing application connected to the CoreAudio Manager is running when 
you quit the Manager, you might receive an error message and lose your connection to 
the Pro Tools hardware.

7. Close the Audio Project Settings dialog box.

Importing with Multichannel Audio

You can use the Import Settings dialog box to define the audio track formats for the audio 
channels in your imported media, up to a maximum of 16 audio channels for the clips in 
your bins. This allows you to specify which source channels are treated as mono or 
multichannel audio tracks in your project, rather than having to modify the clips in your bin 
after you import the source media.
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The mappings affect all media clips created when you import your source media. If you want 
to use different mixes for different master clips or different projects, create a custom Import 
Settings template for each separate type of mix and then import your clips. For information 
on creating custom Import settings, see “Creating and Modifying Import Settings” in the 
Help.

Multichannel audio settings do not apply to the following formats when you import media or 
files:

• AAF

• OMFI

• Shot log files

• Tab-delimited files

Each stereo track requires two channels, but you can mix mono and stereo input channels for 
your linking operation as long as you do not exceed the maximum of 16 audio channels for 
each master clip.

To specify the multichannel audio mix for imported clips:

1. Do one of the following:

t Open a bin, select File > Import, and then click the Options button in the Select 
Files to Import dialog box.

t In the Project window, click the Settings tab and then double-click Import.

The Import Settings dialog box appears.

You can also open the Import Settings dialog box by clicking the Options button in the 
For information about the Import Settings, see “Import Settings” in the Help.

2. Click the Audio tab.

The Multichannel Audio section of the Audio tab lists any multichannel audio mappings 
in the current Import Settings template.
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3. Click Edit. 

The Set Multichannel Audio dialog box opens.

4. Click the format buttons to select one of the following audio track formats for each pair 
of source channels:

Button Track Format

Mono
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You must map source audio channels in mono or stereo pairs. For example, you cannot 
map A1 to a mono track and A2 and A3 to a stereo track. Instead, map A1 and A2 to 
mono tracks, and A3 and A4 to a stereo track. If the source media does not have an 
audio channel on A2, the Avid editing application ignores the channel.

5. Click OK to close the Set Multichannel Audio dialog box, and then click OK to close 
the Import Settings dialog box.

The Track Formats column in the bin Text view displays the format for all multichannel 
audio tracks in a master clip.

Suggested Uses for Locators
The following table describes some possible uses for locators and the Locators window:

Stereo

Button Track Format

Use Description

Color correction 
notations

Use locators to mark clips or specify frames that require color correction, 
noting the specific correction to perform if someone else does the job.

Visual track alignments Use locators at matching points in synchronized audio and video tracks 
so that if the tracks lose sync, you can visually realign the locators in the 
Timeline to restore sync. For more information on sync, see “Working 
with Multiple Tracks” in the Help.

Music cues Use locators to mark the IN and OUT points for music.

Audio information sent to 
Avid Pro Tools

Use locators to mark places in the sequence for advanced audio editing 
in Pro Tools or to indicate video data useful to your Pro Tools editor.

Trim markers Use locators in the Timeline to return directly to an edit you have 
designated for further trimming at a later time.

Cutaway markers Use locators to identify cutaway shots with comments so that when you 
return to cover jump-frame edits with cutaway footage, you can quickly 
call up the shots using basic Find procedures.

Replace markers Use locators to mark filler segments with comments to identify the items 
that should replace the filler.

Semi-permanent IN or 
OUT points

Use locators with the Mark Locators button to put multiple sets of 
locators on a long clip, and so on.
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When you insert a locator, it appears as an oval in the Timeline, in the position bar, and at the 
bottom of the frame in the monitor. The color of the oval corresponds to the color of the 
locator button you used.

Example of a locator in the monitor, the position bar, and the Timeline

You can add locators to your source material while you are in an editing session, as 
described in “Adding Locators While Editing” in the Help.

When you export sequences with locators as AAF files, the locator information is included. 
A Pro Tools editor can then choose to import the locators as Pro Tools as markers. The 
markers contain the same information as locators in your Avid editing system.

Mapping Audio Tracks to Output Channels

The Multiple Mix Editor dialog box allows you to map any combination of audio tracks to 
any of the 16 available output channels when you send a sequence to playback using 
Interplay Transfer. The Send To Playback operation performs a mixdown on the selected 
tracks before the application sends the sequence to Interplay Transfer.

Add comments for EDLs Use locators to add comments to sequence clips to appear in lists that 
you create, such as an EDL or cut list.

Viewing reviewer 
comments

Use the Locators window to view reviewer comments and the specific 
frame. See “Using the Locators Window” in the Help.

Print a list of reviewer 
comments

Use the Locators window to print a list of changes or comments that you 
can distribute to other people in the production. See “Using the Locators 
Window” in the Help.

Import and export 
locators

Import or export locators from one sequence or clip into another 
sequence or clip. See “Exporting and Importing Locators” in the Help.

Use Description
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The mappings you create in the Multiple Mix Editor affect any sequence you send to 
playback. If you want to use different mixes for different sequences, create a custom 
Transfer Settings template for each separate type of mixdown.

• You can map a single audio track in the Timeline to a single output track — for 
example, you can map audio tracks 2, 4, 6, and 8 to output channels 1, 2, 3, and 4, 
respectively. Stereo tracks require two output channels in the sequence that you send to 
playback unless you want to perform a stereo-to-mono mixdown.

• You can select multiple audio tracks and map them to a singe output channel — for 
example, you can map audio tracks 4, 5, 8, and 9 to output channel 1.

• You can map a single track to multiple channels — for example, you can map track 2 to 
output channels 1, 3, and 5.

• You can save your map as a custom Transfer settings template.

Each stereo output requires two channels, but you can mix mono and stereo channels for 
your Send to Playback operation as long as you do not exceed the maximum of 16 output 
channels.

To create a map of audio tracks to output channels:

1. In the Avid editing application, click the Settings tab in the Project window.

2. Double-click Transfer in the Settings list.

The Transfer Settings dialog box opens.

3. Click the Settings tab.
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4. In the Output Audio Mix area, select Multiple Mixes, and then click Edit.

The Multiple Mix Editor dialog box opens.
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5. Click the Format buttons to cycle through the available options until you find the 
appropriate format:

6. In the track selector row, click the channel or channels for each audio track you want to 
include in your output. If the track is not visible, use the scroll bar to locate the track you 
want to map to an output channel.

The audio channel button and the corresponding Output button change to purple. You 
can click the channel button again to remove it from the output mixdown. You can also 
click the Output button to remove it from the from the output. Only active output 
channels are sent to playback.

7. (Option) In the Label text box, type a label to identify the type of output for your 
mixdown. You can use the labels to describe the kind of mixdown for your output, but 
the Avid editing application does not send this information to the playback device.

Option Description

Mono tracks Maps audio tracks to mono channels, with any assigned stereo tracks 
mixed down to a mono channel.

Stereo track Maps audio tracks to a single stereo channel, using the pan 
information on the input tracks to generate stereo output.
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8. Repeat steps 5 through 8 to map additional audio tracks to output channels.

9. When you finish assigning tracks to output channels, click OK to save your mixdown 
sequence.

The Multiple Mix Editor closes.

10. In the Transfer Settings dialog box, click OK.

To save a custom map of output audio channels as a settings template:

1. Click the Settings tab in the Project window.

The Settings list appears.

2. Click Transfer.

3. Select Edit > Duplicate.

A duplicate setting appears in the Settings list.

4. Name the setting by doing the following:

a. Click the custom name column.

b. Type a name.

c. Press Enter (Windows) or Return (Macintosh).

n The custom name column is the center column in the Project window. When you move the 
pointer over the custom name column, the pointer changes from a pointing finger to a text 
insertion bar.
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You can select this new setting whenever you send a sequence to playback using 
Interplay Transfer.

AIR Avid Audio Plug-Ins
The following table provides a brief description of each of the AIR core plug-ins, with 
cross-references to more detailed information in the remaining topics in this section.

You can use RTAS track effect plug-ins on both mono and stereo tracks. You can use some 
AudioSuite plug-ins in either mono or stereo clips. For more information, see “Using 
AudioSuite Plug-Ins in Stereo” in the Help.

Audio Plug-ins  

Plug-In Description

AIR Chorus Gives depth and space to the audio signal.by applying a short modulated delay. For 
more information, see “AIR Chorus (RTAS)” on page 43.

AIR Distortion Modifies the audio signal with various types of distortion. For more information, see 
“AIR Distortion (RTAS)” on page 44.

AIR Dynamic Delay Creates a delay line that can synchronize to the tempo of your audio sequence. For 
more information, see “AIR Dynamic Delay (RTAS)” on page 45.

AIR Enhancer Enhances the low and high broadband frequencies of the audio signal. For more 
information, see “AIR Enhancer (RTAS)” on page 47.

AIR Ensemble Creates fluid, shimmering modulation effects. For more information, see “AIR 
Ensemble (RTAS)” on page 48.

AIR Filter Gate Breaks the audio signal into staccato rhythmic patterns with variable filtering, 
amplitude, and panning. For more information, see “AIR Filter Gate (RTAS)” on 
page 48.

AIR Flanger Applies a short modulating delay. For more information, see “AIR Flanger (RTAS)” on 
page 49.

AIR Frequency Shifter Shifts the audio signal’s individual frequencies inharmonically. For more information, 
see “AIR Frequency Shifter (RTAS)” on page 52.

AIR Fuzz-Wah Modifies the audio signal with different types and varying amounts of transistor-like 
distortion. For more information, see “AIR Fuzz-Wah (RTAS)” on page 53.

AIR Kill EQ Removes the Low, Mid, or High broadband frequency range from an audio signal. For 
more information, see “AIR Kill EQ (RTAS)” on page 54.
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AIR Chorus (RTAS)

You can use the AIR Chorus plug-in to apply a short modulated delay to give depth and 
space to the audio signal.

The following table lists the AIR Chorus plug-in parameters:

AIR Lo Fi Lets you bit-crush, down-sample, clip, rectify, and mangle the input signal. For more 
information, see “AIR Lo Fi (RTAS)” on page 54.

AIR Multi-Chorus Applies a thick, complex chorus effect to the audio signal. For more information, see 
“AIR Multi-Chorus (RTAS)” on page 57.

AIR Multi-Delay Applies up to six delay lines to the audio signal. For more information, see “AIR 
Multi-Delay (RTAS)” on page 58.

AIR Non-Linear Reverb Creates special gated or reversed reverb effects. For more information, see “AIR 
Non-Linear Reverb (RTAS)” on page 59/

AIR Phaser Creates a unique sweeping sound by applying a phaser effect. For more information, 
see “AIR Phaser (RTAS)” on page 60.

AIR Reverb Creates a sense of room or space by applying a reverb to the audio signal. For more 
information, see “AIR Reverb (RTAS)” on page 62.

AIR Spring Reverb Creates a classic analog, spring reverb sound. “AIR Spring Reverb (RTAS)” on 
page 64.

AIR Stereo Width Lets you enhance the stereo presence for mono audio signals. For more information, 
see “AIR Stereo Width (RTAS)” on page 65.

AIR Talkbox Adds voice-like resonances to audio signals. For more information, see “AIR Talkbox 
(RTAS)” on page 66.

AIR Vintage Filter Applies a modulating, resonant filter to the audio signal. For more information, see 
“AIR Vintage Filter (RTAS)” on page 68.

Audio Plug-ins  

Plug-In Description

Parameter Description

Rate Lets you adjust the rate of the low frequency oscillator (LFO) applied to the delayed signal as 
modulation. The higher the setting, the more rapid the modulation. You can select either a sine 
wave or a triangle wave as a modulation source, using the LFO Waveform selector.
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AIR Distortion (RTAS)

You can use the AIR Distortion plug-in to color the audio signal with various types and 
varying amounts of distortion.

The following table lists the AIR Distortion plug-in parameters:

Depth Lets you adjust the depth of the low frequency oscillator (LFO) applied to the delayed signal as 
modulation.

Chorus • Feedback — Controls the amount of feedback applied from the output of the delayed signal 
back into its input. Negative settings provide a more intense effect.

• Pre Delay — Sets the delay time between the source chorus signal and the processed signal 
in milliseconds. The higher the setting, the longer the delay and the wider the chorusing 
effect.

LFO • Waveform — Selects a triangle or a sine wave for the LFO. This affects the character of the 
modulation. The sine wave has a gentler ramp and peak than the triangle wave.

• L/R Phase — Sets the relative phase of the LFO’s modulation in the left and right channels.

Mix Lets you adjust the balance between the Dry (source) signal and the Wet (processed) signal, 
giving you control over the depth of the effect. 0% is all dry, and 100% is all wet, while 50% is 
an equal mix of both.

Parameter Description

Parameter Description

Drive Lets you increase the drive (input volume) of the signal from 0 dB (no distortion) to 60 dB 
(extreme distortion). An increase or decrease of 1– 2 decibels can make a big difference on the 
amount and quality of distortion.

Output Lets you lower the Output level of the distorted signal from 0–100%. At 0%, no distorted signal 
passes through the output. At 100%, the distorted signal passes through the output at full 
volume.

Tone Lets you shape the timbral quality of the distortion.

• Pre Shape — Lets you increase or decrease a broad gain boost (or attenuation) of treble 
frequencies in the processed signal. Pre-Shape is essentially a pre-distortion tone control that 
makes the distortion bite at different frequencies. Set to 0%, the Pre-Shape control doesn’t 
affect the tone at all. Higher settings provide a boost in the high end of the distorted signal 
(more treble distortion), while lower setting suppress the high end, with some mid-range 
boost, for a darker less distorted tone.

• High Cut — Lets you adjust the frequency for the High Cut filter. To attenuate the high-end 
of the processed signal, lower the frequency.
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AIR Dynamic Delay (RTAS)

You can use the Dynamic Delay Plug-In for a delay line that can synchronize to the tempo of 
your audio sequence, and you can modulate the delay using an envelope follower.

The following table lists the AIR Dynamic Delay plug-in parameters:

Clipping • DC Bias — Lets you change clipping from being symmetrical to being asymmetrical, which 
makes it sound richer and more extreme at high settings. The difference is most noticeable at 
lower Drive settings.

• Threshold — Lets you adjust the headroom for the dynamic range of the distorted signal 
between –20.0 dBFS and 0.0 dBFS. Rather than using the Drive to adjust the signal level 
relative to a fixed clipping level, use the Threshold control to adjust the clipping level 
without changing the signal level.

Stereo When you enable Stereo, the control processes the left and right channels of the incoming stereo 
signal separately. When you disable Stereo, the control sums and processes the incoming stereo 
signal as mono.

Mix Lets you balance the amount of dry signal with the amount of wet (distorted) signal. At 50%, the 
output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it 
is all wet.

You can use the Mix control in conjunction with the Output control to find just the right balance 
of the distorted signal with the input (dry) signal. For example, with Mix set to 50%, equal 
amounts of the dry and wet signal pass to the output. You can then lower the Output control to 
decrease the amount of distorted signal passed to the output until you get exactly the right mix 
between the two signals and the right overall level.

Parameter Description

Parameter Description

Sync When you enable Sync, the delay time synchronizes to the tempo of your audio sequence. When 
you disable Sync, you can set the delay time in milliseconds independently of the tempo. The 
Sync button is lit when it is enabled.
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Delay When you enable Sync, the Delay control lets you select a rhythmic subdivision or multiple of 
the beat for the delay time (based on the tempo). Select from the following rhythmic values:

• 16 (sixteenth note)

• 8T (eighth-note triplet)

• 16D (dotted sixteenth-note)

• 8 (eighth note)

• 4T (quarter-note triplet)

• 8D (dotted eighth-note)

• 4 (quarter note)

• 2T (half-note triplet)

• 4D (dotted quarter-note)

• 2 (half note)

• 1T (whole-note triplet)

• 3/4 (dotted half note)

• 4/4 (whole note)

• 5/4 (five tied quarter notes)

• 6/4 (dotted whole note)

• 7/4 (seven tied quarter notes)

• 8/4 (double whole note)

When you disable Sync, the Delay control lets you set the delay time in milliseconds and 
seconds (1 ms to 4.00 seconds).

Feedback Lets you adjust the amount of delay feedback. At 0% the delayed signal repeats only once. As 
you increase the feedback, the number of times the delay repeats increases. At 100%, the delay 
repeats for an extended period of time.

Each Delay mode produces a different feedback pattern, especially when you do not center the 
L/R Ratio.

Delay Section • L/R Ratio — Lets you set the ratio of left to right delay times. If you move the control all the 
way to the left (50:100), the left channel delay time equals half the right channel delay time. 
If you move the control all the way to the right (100:50), the right channel delay time equals 
half the left channel delay time.

• Stereo Width — Lets you adjust the width of the delay effect in the stereo field.

Parameter Description
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AIR Enhancer (RTAS)

You can use the Enhancer plug-in to enhance the low and high broadband frequencies of the 
audio signal.

The following table lists the AIR Enhancer plug-in parameters:

EQ • Low Cut — Lets you adjust the frequency for the Low Cut filter. For less bass, raise the 
frequency.

• High Cut — Lets you adjust the frequency for the High Cut filter. For less treble, lower the 
frequency.

Env Mod The Dynamic Delay plug-in provides Envelope Modulation (an envelope follower) to control 
various parameters in real time.

• Rate — Determines how quickly the Feedback and Mix parameters respond to input from 
the envelope follower.

• FBK — Determines how much the envelope follower affects the Feedback (FBK) amount.

• Mix — Determines how much the envelope follower affects the wet/dry mix. At 0%, the 
envelope follower has no effect on the given parameter. At +/– 100%, the parameter’s value 
increases or decreases in direct proportion to the incoming signal’s amplitude envelope.

Feedback 
Mode

Select one of the following options for the Feedback Mode:

• Mono — Sums the incoming stereo signal to mono, then offers separate left and right delay 
output taps from that signal.

• Stereo — Processes the left and right channels of the incoming stereo signal independently 
and outputs the processed signal on the corresponding left and right channels.

• Cross — Processes the left and right channels of the incoming stereo signal independently, 
and feeds the each side’s delayed signal back to the opposite channel.

Mix Lets you balance the amount of dry signal with the amount of wet (delayed) signal. At 50%, the 
output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it 
is all wet.

Parameter Description

Parameter Description

High Gain Adjusts the frequency to boost the high end.

Low Gain Adjusts the frequency to boost the low end.
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AIR Ensemble (RTAS)

You can use the Ensemble plug-in to apply fluid, shimmering modulation effects to the 
audio signal.

The following table lists the AIR Ensemble plug-in parameters:

AIR Filter Gate (RTAS)

You can use the Filter Gate effect to chop up the audio signal into staccato rhythmic patterns 
with variable filtering, amplitude, and panning.

The following table lists the AIR Filter Gate plug-in parameters:

Tune Lets you set the center frequency for low and high-end enhancement.

• Low — Sets the center frequency for the bass boost.

• High — Sets the center frequency for the treble boost.

Harmonic 
Generation

Lets you generate additional high-frequency harmonics, which can brighten up dull signals.

• Depth — Generates additional high frequency harmonics in the signal (0.0–12.0 dB).

• Phase — Toggles the polarity of the generated harmonics, changing their phase relationship 
with the dry signal.

Output Lets you lower the Output level from 0.0 dB to –INF dB.

Parameter Description

Parameter Description

Rate Changes the frequency of the modulating LFO (0.01–10.0 Hz).

Depth Adjusts the amount of modulation applied to the Delay time.

Modulation Lets you adjust and randomize the delay time.

• Delay — Adjusts the Delay time.

• Shimmer — Lets you randomize the Delay time, adding texture to the effect.

Stereo Width Lets you widen or narrow the effect’s stereo field.

Mix Lets you balance the amount of dry signal with the amount of wet (processed) signal. At 50%, 
the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 
100% it is all wet.
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AIR Flanger (RTAS)

You can use the Flanger plug-in to apply a short modulating delay to the audio signal.

The following table lists the AIR Flanger plug-in parameters:

Parameter Description

Pattern Lets you select from a number of preset rhythmic patterns that the gate will follow.

Gate • Attack — Lets you adjust the duration of the attack as a percentage of the step duration.

• Hold — Lets you adjust the duration of the hold (or sustain) as a percentage of the step 
duration.

• Release — Lets you adjust the duration of the release as a percentage of the step duration.

Filter Provides controls for the selected filter type:

• Mode — Lets you select the type of Filter:

• Off (no filtering)

• LP (Low Pass filter)

• BP (Band Pass filter)

• HP (High Pass filter)

• Phaser (Phaser)

• Cutoff — Lets you adjust the Filter Cutoff frequency.

• Res — Lets you adjust the Resonance at the Cutoff frequency.

Modulation • Env — Lets you adjust how much an envelope follower affects the Cutoff frequency. Note 
that the Cutoff is fixed for the duration of each step, so it will not respond to a peak in the 
envelope until the start of the next step.

• LFO — Lets you adjust the amount of LFO modulation of the Cutoff frequency.

• LFO Steps — Sets the duration of one cycle of the LFO to the selected number of steps. 
Changes to the Step Rate consequently affect the durations of cycles of the LFO. When set 
to Random mode, the level of the LFO changes randomly every step, for a “sample and 
hold” waveform.

Rate Lets you select the duration, or frequency of the Low Frequency Oscillator (LFO). The duration 
of one cycle of the LFO is measured in Steps.

Mix Lets you balance the amount of dry signal with the amount of wet (filtered) signal. At 50%, the 
output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it 
is all wet.



  

50

Parameter Description

Sync Synchronizes the modulation rate to the audio sequence tempo. When you enable Sync, you can 
select a rhythmic subdivision or multiple of the beat for the Flanger modulation rate. When you 
disable Sync, you can set the delay time in milliseconds independently of the sequence tempo.

•  — Select from the following rhythmic values:

• 16 (sixteenth note)

• 8T (eighth-note triplet)

• 16D (dotted sixteenth-note)

• 8 (eighth note)

• 4T (quarter-note triplet)

• 8D (dotted eighth-note)

• 4 (quarter note)

• 2T (half-note triplet)

• 4D (dotted quarter-note)

• 2 (half note)

• 1T (whole-note triplet)

• 3/4 (dotted half note)

• 4/4 (whole note)

• 5/4 (five tied quarter notes)

• 6/4 (dotted whole note)

• 8/4 (double whole note)

• Depth — Lets you adjust the amount of modulation applied to the Delay time.
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Rate Lets you select from the following rhythmic values:

• 16 (sixteenth note)

• 8T (eighth-note triplet)

• 16D (dotted sixteenth-note)

• 8 (eighth note)

• 4T (quarter-note triplet)

• 8D (dotted eighth-note)

• 4 (quarter note)

• 2T (half-note triplet)

• 4D (dotted quarter-note)

• 2 (half note)

• 1T (whole-note triplet)

• 3/4 (dotted half note)

• 4/4 (whole note)

• 5/4 (five tied quarter notes)

• 6/4 (dotted whole note)

• 8/4 (double whole note)

Depth Lets you adjust the amount of modulation applied to the Delay time.

Pre-Delay Sets the minimum delay time in milliseconds.

LFO Provides controls for the Low Frequency Oscillator (LFO) used to modulate the Delay time.

• Retrigger — Resets the LFO phase. This lets you manually start the filter sweep from that 
specific point in time (or using automation, at a specific point in your arrangement). Clicking 
the Retrigger button also forces the Mix control up if it is too low while the button is held. 
This ensures that the sweep is audible.

• Wave — lets you interpolate between a triangle wave and a sine wave for the modulating 
LFO.

• L/R Offset — Lets you adjust the phase offset for the LFO waveform applied to the left and 
right channels.

Parameter Description
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AIR Frequency Shifter (RTAS)

You can use the Frequency Shifter plug-in to shift the audio signal’s individual frequencies 
inharmonically, creating a unique effect.

The following table lists the AIR Frequency Shifter plug-in parameters:

EQ Provides controls for cutting lows from the Flanger signal, and inverting phase.

• Phase Invert — When enabled, Phase Invert flips the wet signal’s polarity, which changes 
the harmonic structure of the effect.

• Low Cut — Lets you adjust the Low Cut frequency for the Flanger, to limit the Flanger 
effects to higher frequencies.

Feedback Lets you adjust the amount of delay feedback for the Flanger. At 0%, the delay repeats only 
once. At +/–100%, the Flanger feeds back on itself.

Mix Lets you balance the amount of dry signal with the amount of wet (flanged) signal. At 50%, the 
output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it 
is all wet.

You can use the Mix control to create an “infinite phaser” effect between the dry and shifted 
signals, which always rises or always falls (depending on the direction of shift).

Parameter Description

Parameter Description

Frequency Sets the amount of frequency shifting.

Shifter Provides control over the direction of frequency shift, and feedback of the signal through the 
algorithm.

• Mode — Sets the direction of the frequency shifting effect:

• Up — Shifts frequencies up.

• Down — Shifts frequencies down.

• Up & Down — Shifts frequencies equally up and down, and the two shifted signals are heard 
simultaneously.

• Stereo — Shifts the right channel frequencies up, and the left channel down.

• Feedback — Lets you run the signal through the pitch shifting algorithm multiple times, 
creating a cascading, layered effect.

Mix Lets you balance the amount of dry signal with the amount of wet (delayed) signal. At 50%, the 
output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it 
is all wet.
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AIR Fuzz-Wah (RTAS)

You can use the Fuzz-Wah plug-in to color the audio signal with different types and varying 
amounts of transistor-like distortion.

The following table lists the AIR Fuzz-Wah plug-in parameters:

Parameter Description

Fuzz Turns the distortion effect on and off.

Drive Sets the level of gain in the Fuzz algorithm.

Mix (Fuzz) Lets you balance the amount of dry signal with the amount of wet (distorted) signal. At 50%, the 
output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it 
is all wet.

Post Wah Lets you reverse the Fuzz section and the Wah section, placing one before the other.

Fuzz section Provides tonal and volume control over the plug-in.

• Tone — Lets you change the brightness of the Fuzz algorithm.

• Output — Sets the overall output volume of the Fuzz section.

Pedal Min • Freq — Sets the low (Pedal Min) limit of the wah filter’s frequency sweep.

• Res — Sets the low (Pedal Min) limit of the wah filter’s resonance.

Pedal Max • Freq — Sets the high (Pedal Max) limit of the wah filter’s frequency sweep.

• Res — Sets the high (Pedal Max) limit of the wah filter’s resonance.

Modulation Provides controls for the Low Frequency Oscillator (LFO) and Envelope Follower (ENV) that 
can be used to modulate the wah filter’s sweep.

• Rate — Sets either the LFO frequency, or the response time of the envelope follower, 
depending on the setting of the Mode control.

• Type — Lets you select either the LFO or the Envelope follower as the modulation source 
for the wah filter.

• Depth — Sets the amount of modulation sent by the LFO or envelope follower.

Wah Lets you turn the wah filter on and off.

Pedal Sweeps the wah center frequency up and down.

Filter Switches the wah filter between LP (lowpass), BP (bandpass), and HP (highpass) modes.

Mix (Wah) Lets you balance the amount of dry signal with the amount of wet (wah-processed) signal. At 
50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 
100% it is all wet.
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AIR Kill EQ (RTAS)

You can use the Kill EQ plug-in to remove the Low, Mid, or High broadband frequency 
range from an audio signal. This is a popular effect with DJs and is commonly used in 
electronic music production (especially in dance music).

The following table lists the AIR Kill EQ plug-in parameters:

AIR Lo Fi (RTAS)

You can use the Lo Fi effect to bit-crush, down-sample, clip, rectify, and mangle the input 
signal.

The following table lists the AIR Lo Fi plug-in parameters:

Mix (overall) Lets you balance the amount of fuzz-processed signal with the amount of wah-processed signal. 
At 50%, there are equal amounts of fuzz and wah signal. At 0%, the output is all fuzz, and at 
100% it is all wah.

Parameter Description

Parameter Description

High Switches the high frequency band on and off.

Mid Switches the middle frequency band on and off.

Low Switches the low frequency band on and off.

Gain • Low — Controls the volume of the low frequency band.

• Mid — Controls the volume of the middle frequency band.

• High — Controls the volume of the high frequency band.

Freq • Low — Sets the crossover frequency of the low pass filter.

• Sweep — Changes both the low and high-band cutoff frequencies simultaneously. When you 
kill the high and low bands, manipulating this control creates a swept bandpass filter effect.

• High — Sets the crossover frequency of the high pass filter.

Output Sets the final output volume.

Parameter Description

Sample Rate Lets you resample the audio signal at another sample rate.
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Anti-Alias Provides control over anti-aliasing filters that you can use before and after downsampling to 
reduce aliasing in the resampled audio signal.

• On — Lets you enable or disable the Anti-Alias filter. Disabling the filter creates a much 
grittier sound.

• Pre — Lets you adjust the anti-aliasing filter cutoff applied to the audio signal before 
resampling. The filter is applied as a multiplier of the sample frequency (Fs) between 0.12 Fs 
and 2.00 Fs.

• Post — Lets you adjust the range of anti-aliasing filter cutoff applied to the audio signal after 
resampling. The filter is applied as a multiplier of the sample frequency (Fs) between 0.12 Fs 
and 2.00 Fs.

Parameter Description
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LFO Lets you apply a Low Frequency Oscillator to modulate the Sample Rate.

• Sync — Synchronizes the LFO Rate to the audio sequence tempo. When you enable Sync, 
you can select a rhythmic subdivision or multiple of the beat for the LFO Rate. When you 
disable Sync, you can change the modulation rate independently of the sequence tempo.

• Rate — Select from the following rhythmic values:

• 16 (sixteenth note)

• 8T (eighth-note triplet)

• 16D (dotted sixteenth-note)

• 8 (eighth note)

• 4T (quarter-note triplet)

• 8D (dotted eighth-note)

• 4 (quarter note)

• 2T (half-note triplet)

• 4D (dotted quarter-note)

• 2 (half note)

• 1T (whole-note triplet)

• 3/4 (dotted half note)

• 4/4 (whole note)

• 5/4 (five tied quarter notes)

• 6/4 (dotted whole note)

• 8/4 (double whole note)

• Wave — Select from the following waveforms for the LFO:

• Sine (sine wave)

• Tri (triangle wave)

• Saw (saw-tooth wave)

• Square (square wave)

• Morse (Morse code-like rhythmic effect)

• S&H (Sample and Hold modulation)

• Random (random modulation)

• Depth — Lets you adjust the amount of modulation applied to the Sample Rate.

Parameter Description
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AIR Multi-Chorus (RTAS)

You can use the AIR Multi-Chorus plug-in to apply a thick, complex chorus effect to the 
audio signal.

The following table lists the AIR Multi-Chorus plug-in parameters:

Env Mod Provides Envelope Modulator control over an envelope follower that can affect the sample rate. 
You can use this for accentuating and enhancing signal peaks (such as in drum loops) with 
artificially generated high-frequency aliasing.

• Attack — Sets the time it takes to respond to increases in the audio signal level.

• Release — Sets the time it takes to recover after the signal level falls.

• Depth — Determines how much the envelope follower affects the sample rate.

• At 0%, the envelope follower has no affect on the sample rate.

• At +100%, the attack ramps up to the sample rate setting; and the release starts from the 
sample rate setting and ramps down.

• At –100%, the attack starts from the sample rate setting and ramps down; and the release 
ramps up to the sample rate setting.

Distortion Provides controls for adding dirt and grunge to the signal.

• Clip — Adds transistor-like distortion to the signal

• Noise — Adds a noisy, buzz-like edge to the signal.

• Rectify — Acts as a waveshaper, adding aggressive, harsh distortion to the signal.

Bit Depth Lets you truncate the bit depth of the incoming signal from 16 bits all the way down to 1 bit.

Mix Lets you balance the amount of dry signal with the amount of wet (processed) signal. At 50%, 
the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 
100% it is all wet.

Parameter Description

Parameter Description

Rate Sets the rate for the oscillation of the LFO in Hertz.

Depth Sets the depth of LFO modulation of the audio signal in milliseconds.

Chorus Provides control over the low-frequency content and stereo width of the Multi-Chorus effect.

• Low Cut — Lets you adjust the Low Cut frequency for the chorus, to limit the Multi-Chorus 
effects to higher frequencies.

• Width — Lets you widen or narrow the effect’s stereo field.
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AIR Multi-Delay (RTAS)

You can use the Multi-Delay Plug-In to apply up to six delay lines to the audio signal.

The following table lists the AIR Multi-Delay plug-in parameters:

Mod • Pre Delay — Sets the Pre-Delay in milliseconds.

• Waveform — Selects a triangle or a sine wave for the LFO. This affects the character of the 
modulation. The sine wave has a gentler ramp and peak than the triangle wave.

Voices Sets the number of layered chorus effects that are applied to the audio signal. The more voices 
you use, the thicker the effect.

Mix Lets you adjust the balance between the dry signal and the wet (processed) signal, giving you 
control over the depth of the effect. 0% is all dry, and 100% is all wet, while 50% is an equal mix 
of both.

Parameter Description

Parameter Description

Sync When you enable Sync, the delay time synchronizes to the tempo of your audio sequence. When 
you disable Sync, you can set the delay time in milliseconds independently of the tempo. The 
Sync button is lit when it is enabled.

Delay When you enable Sync, the Delay control lets you set the main delay length in 16th-note lengths 
(based on the tempo).

When you disable Sync, the Delay control lets you set the delay time in milliseconds and 
seconds.

Feedback Lets you adjust the amount of delay feedback. At 0% the delayed signal repeats only once. As 
you increase the feedback, the number of times the delay repeats increases. At 100%, the delay 
repeats for an extended period of time.

The From and To controls let you feed signal from one delay tap to another, or back to the main 
input, to create complex delay/feedback effects. If the delay time of the To tap is greater than the 
delay time of the From tap, then the result is “feed-forward” rather than feedback, so you can 
hear only one delay repeat.

• From — Sets the tap from which signal is cross-routed.

• To — Sets the tap (or the main input) to which the cross-routed signal is routed.
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AIR Non-Linear Reverb (RTAS)

You can use the Non-Linear Reverb effect to apply special gated or reversed reverb effects to 
the audio signal, creating a synthetic, processed ambience.

The following table lists the AIR Non-Linear Reverb plug-in parameters:

Delay Taps Provides five Taps (delay lines). Each tap provides the same set of controls. You can edit the 
controls for each tap independently of the other taps.

• On — Turns the selected tap’s signal on or off.

• Delay — Sets the length of delay for the tap, relative to the main Delay setting.

• Level — Changes the output level of the tap.

• Pan — Pans the audio signal from the tap left or right in the stereo field.

High Cut Lets you adjust the frequency for the High Cut filter. For less treble, lower the frequency.

Low Cut Lets you adjust the frequency for the Low Cut filter. For less bass, raise the frequency.

Mix Lets you balance the amount of dry signal with the amount of wet (delayed) signal. At 50%, the 
output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it 
is all wet.

Parameter Description

Parameter Description

Reverse Turns Reverse mode on and off. In Reverse mode, the tail of the reverb signal fades up to full 
volume, then disappears, rather than fading out.

• Pre-Delay — Determines the amount of time that elapses between the original audio event 
and the onset of reverberation. 

• Dry Delay — Applies a specified amount of delay to the dry portion of the signal, which can 
create a “reverse reverb” effect, where the reverb tail is heard before the dry signal.

Reverb Provides control over the reverb’s diffusion and stereo width.

• Diffusion — Changes the rate at which the sound density of the reverb tail increases over 
time. Higher Diffusion settings create a smoother reverberated sound. Lower settings result 
in more fluttery echo.

• Width — Lets you widen or narrow the effect’s stereo field.
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AIR Phaser (RTAS)

You can use the Phaser effect to apply a phaser to the audio signal for a unique sweeping 
sound.

The following table lists the AIR Phaser plug-in parameters:

EQ Provides tonal control over the reverb signal.

• Low Cut — Adjusts the frequency for the Low Cut filter. For less bass, raise the frequency.

• High Cut — Adjusts the frequency for the High Cut filter. For less treble, lower the 
frequency.

Reverb Time Changes the length of the reverberation’s decay.

Mix Lets you balance the amount of dry signal with the amount of wet (processed) signal. At 50%, 
the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 
100% it is all wet.

Parameter Description

Parameter Description

Sync When you enable Sync, the delay time synchronizes to the tempo of your audio sequence. When 
you disable Sync, you can set the delay time in milliseconds independently of the tempo. The 
Sync button is lit when it is enabled.
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Rate When you enable Sync, the Rate control lets you select a rhythmic subdivision or multiple of the 
beat for the Phaser Modulation Rate. When you disable Sync, you can change the phaser rate 
independently of the sequence tempo. Select from the following rhythmic values:

• 16 (sixteenth note)

• 8T (eighth-note triplet)

• 16D (dotted sixteenth-note)

• 8 (eighth note)

• 4T (quarter-note triplet)

• 8D (dotted eighth-note)

• 4 (quarter note)

• 2T (half-note triplet)

• 4D (dotted quarter-note)

• 2 (half note)

• 1T (whole-note triplet)

• 3/4 (dotted half note)

• 4/4 (whole note)

• 5/4 (five tied quarter notes)

• 6/4 (dotted whole note)

• 8/4 (double whole note)

• Wave — Select from the following waveforms for the LFO:

• Sine (sine wave)

• Tri (triangle wave)

• Saw (saw-tooth wave)

• Square (square wave)

• Morse (Morse code-like rhythmic effect)

• S&H (Sample and Hold modulation)

• Random (random modulation)

Depth Lets you adjust the depth of modulation, which in turn affects the amount of phasing applied to 
the audio signal.

Parameter Description
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AIR Reverb (RTAS)

Different physical environments have different early reflection signatures that our ears and 
brain use to localize sound. These reflections affect our perception of the size of a space as 
well as where an audio source sits within it. You can use the Reverb effect to apply Reverb to 
the audio signal, creating a sense of room or space.

The following table lists the AIR Reverb plug-in parameters:

Phaser Provides control over the effect’s center frequency and number of phaser stages (or poles).

• Center — Lets you change the frequency center (100 Hz to 10.0 kHz) for the phaser poles.

• Poles — Lets you select the number of phaser poles (stages): 2, 4, 6, or 8. The number of 
poles changes the character of the sound. The greater the number of poles, the thicker and 
more sweeping the sound.

LFO Provides control over the waveform and stereo offset of the LFO.

• Wave — Lets you interpolate between a triangle wave and a sine wave for modulating the 
phaser.

• L/R Phase — Lets you adjust the relative phase of the LFO modulation applied to the left 
and right channels. 

EQ Provides tonal control over the phase signal. The Low Cut control lets you adjust the frequency 
of the Low Cut Filter in the phaser’s feedback loop. This can be useful for taming low frequency 
“thumping” at high feedback settings.

Feedback Feeds the output signal of phaser back into the input, creating a resonant or singing tone in the 
phaser when set to its maximum.

Mix Lets you balance the amount of dry signal with the amount of wet (effected) signal. At 50%, the 
output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it 
is all wet.

Parameter Description

Parameter Description

Pre-Delay Determines the amount of time that elapses between the original audio event and the onset of 
reverberation. Under natural conditions, the amount of pre-delay depends on the size and 
construction of the acoustic space, and the relative position of the sound source and the listener. 
Pre-Delay attempts to duplicate this phenomenon, and you can use it to create a sense of 
distance and volume within an acoustic space. Long Pre-Delay settings place the reverberant 
field behind rather than on top of the original audio signal.

Room Size Changes the apparent size of the space.
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Early 
Reflections

Changes the perceived location of the reflecting surfaces surrounding the audio source.

Reverb simulates early reflections by using multiple delay taps at different levels that occur in 
different positions in the stereo spectrum (through panning). Long reverberation generally 
occurs after early reflections dissipate. 

• Type — Provides the following Types of Early Reflection models:

• Booth (a vocal recording booth)

• Club (a small, clear, natural-sounding club ambience)

• Room (the center of a small room without many reflections)

• Small Chamber (a bright, small-sized room)

• Medium Chamber (a bright, medium-sized room)

• Large Chamber (a bright, large-sized room)

• Small Studio (a small, live, empty room)

• Large Studio (a large, live, empty room)

• Scoring Stage (a scoring stage in a medium-sized hall)

• Philharmonic (the space and ambience of a large, symphonic, concert hall)

• Concert Hall (the space and ambience of a large concert hall)

• Church (a medium-sized space with natural, clear-sounding reflections)

• Opera House (the space and ambience of an opera house)

• Vintage 1 (a vintage digital reverb effect)

• Vintage 2 (a vintage digital reverb effect)

• Spread — Controls the length of the early reflections.

Reverb Provides control over the stereo width of the reverb algorithm.

• In Width — Widens or narrows the stereo width of the incoming audio signal before it enters 
the reverb algorithm.

• Out Width — Widens or narrows the stereo width of the signal once reverb has been applied.

• Delay — Sets the size of the delay lines used to build the reverb effect. Higher values create 
longer reverberation.

EQ Provides tonal control over the reverb signal.

• Low Cut — Adjusts the frequency for the Low Cut filter. For less bass, raise the frequency.

• High Cut — Adjusts the frequency for the High Cut filter. For less treble, lower the 
frequency.

Parameter Description
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AIR Spring Reverb (RTAS)

You can use the Spring Reverb effect to apply a classic spring reverb sound. The analog 
spring reverb feeds a signal to a transducer at the end of a suspended metal coil spring. The 
transducer causes the spring to vibrate so that the signal reflects from one end of the spring 
to the other. At the other end of the spring another transducer converts the motion of the 
spring back into an electrical signal, which creates a delayed and reverberated version of the 
input signal. The Spring Reverb effect models this analog effect.

Room Controls the overall spatial feel of the simulated room.

• Ambience — Affects the attack of the reverb signal. At low settings, the reverb arrives 
quickly, simulating a small room. At higher settings, the reverb ramps up more slowly, 
emulating a larger room.

• Density — Changes the rate at which the sound density of the reverb tail increases over time. 
Higher Density settings create a smoother reverberated sound. Lower settings result in more 
fluttery echo.

High 
Frequencies

Provides controls that let you shape the tonal spectrum of the reverb by adjusting the decay 
times of higher frequencies.

• Time — Decreases or increases the decay time for mid- to high-range frequency bands. 
Higher settings provide longer decay times and lower settings provide shorter decay time. 
With lower settings, high frequencies decay more quickly than low frequencies, simulating 
the effect of air absorption in a hall.

• Freq — Sets the frequency boundary between the mid- and high-range frequency bands.

• Cut — Adjusts the frequency for the High Cut filter (1.00–20.0 kHz). Adjusting the High 
Cut control changes the decay characteristics of the high frequency components of the 
Reverb. To cut the high-end of the processed signal, lower the frequency.

Low 
Frequencies

Controls the low-frequency-heavy tail of the reverb signal.

• Time — Decreases or increases the decay time for the low-range frequency band. Higher 
settings provide longer decay times and lower settings provide shorter decay time. 

• Freq — Sets the frequency boundary between the low and high-range frequency bands.

Reverb Time Changes the rate at which the reverberation decays after the original direct signal stops. At its 
maximum value, infinite reverberation is produced.

Balance Changes the output level of the early reflections. Setting the level control to 0% produces a 
reverb effect that is only the reverb tail.

Mix Lets you balance the amount of dry signal with the amount of wet (processed) signal. At 50%, 
the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 
100% it is all wet.

Parameter Description
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The following table lists the AIR Spring Reverb plug-in parameters:

AIR Stereo Width (RTAS)

You can use the Stereo Width effect to create a wider stereo presence for mono audio 
signals.

The following table lists the AIR Stereo Width plug-in parameters:

Parameter Description

Pre-Delay Determines the amount of time (0–250 ms) that elapses between the original audio event and the 
onset of reverberation.

Reverb Provides control over the diffusion and stereo width of the reverb signal.

• Diffusion — Changes the rate at which the sound density of the reverb tail increases over 
time. Higher Diffusion settings create a smoother reverberated sound. Lower settings result 
in more fluttery echo.

• Width — Changes the spread of the reverberated signal in the stereo field. A setting of 0% 
produces a mono reverb, but leaves the panning of the original source signal unprocessed. A 
setting of 100% produces a open, panned stereo image.

Low Cut Lets you adjust the frequency of the Low Cut Filter (20.0 Hz–1.00 kHz). Use the Low Cut filter 
to reduce some of the potential low frequency resonance (or booming) you can get with longer 
reverb times.

Reverb Time Changes the reverberation decay time (1.0–10.0 seconds) after the original direct signal stops. 
Shorter times result in a tighter, more ringing and metallic reverb, such as when walking down a 
narrow hall with hard floors and walls. Longer times result in a larger reverberant space, such as 
an empty, large, concrete cistern. 

Mix Lets you balance the amount of dry (non-reverb) signal with the amount of wet (reverb) signal. 
At 50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry 
and at 100% it is all wet.
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AIR Talkbox (RTAS)

You can use the Talkbox effect to add voice-like resonances to audio signals.

The following table lists the AIR Talkbox plug-in parameters:

Parameter Description

Mode Lets you specify the method by which the Stereo Width plug-in will create the artificial stereo 
field.

• Adjust — Adjusts the existing stereo width of the signal by M-S encoding, equalizing the S 
component with the Low/Mid/High controls and boosting/attenuating it with the Width 
control, then M-S decoding back to stereo. The Delay control delays the right signal relative 
to the left for an additional widening effect (known as “Haas panning”).

• Comb — Adds artificial width to the signal by M-S encoding then adding a delayed version 
of the M component to the S component. This creates a comb filtering effect that shifts some 
frequencies to the left and others to the right.

• Phase — Affects how the Low/Mid/High controls set the centre frequencies of 3 phase 
shifters. This shifts the relative phase of the left and right channels, giving a much more 
subtle effect than Comb mode.

Process Boosts or cuts the Low, Mid and High-frequency bands of the generated stereo signal.

Trim Adjusts the perceived center/source of the generated stereo signal.

• Level — Sets the volume of the perceived center of the stereo signal.

• Pan — Sets the position left-to-right of the perceived center of the stereo signal.

Delay Lets you specify the duration of delay used in Phase mode (0–8 ms).

Width Sets the final width of the generated stereo field.

Parameter Description

Vowel Lets you choose the shape of the formant filter, by the vowel sound that is simulated 
(OO/OU/AU/AH/AA/AE/EA/EH /EE/ER/UH/OH).

Env Depth Creates a positive or negative offset in the setting of the Vowel control, effected by the envelope 
follower. At its center, the knob has no effect. Turned to the right or left of center, the Env Depth 
knob shifts the value of the Vowel control up or down.

When you trigger the envelope follower, the Vowel parameter moves to its normal setting (in 
time with the envelope’s attack), then back to the offset value (in time with the envelope’s 
release).
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LFO Provides controls that let you apply a Low Frequency Oscillator to modulate the Formant 
setting.

• Sync — Synchronize the LFO Rate to the audio sequence tempo. When you enable Sync, 
you can select a rhythmic subdivision or multiple of the beat for the LFO Rate. When you 
disable Sync, you can change the modulation rate independently of the sequence tempo.

• Rate — Select from the following rhythmic values:

• 16 (sixteenth note)

• 8T (eighth-note triplet)

• 16D (dotted sixteenth-note)

• 8 (eighth note)

• 4T (quarter-note triplet)

• 8D (dotted eighth-note)

• 4 (quarter note)

• 2T (half-note triplet)

• 4D (dotted quarter-note)

• 2 (half note)

• 1T (whole-note triplet)

• 3/4 (dotted half note)

• 4/4 (whole note)

• 5/4 (five tied quarter notes)

• 6/4 (dotted whole note)

• 8/4 (double whole note)

• Wave — Select from the following waveforms for the LFO:

• Sine (sine wave)

• Tri (triangle wave)

• Saw (saw-tooth wave)

• Square (square wave)

• S&H (Sample and Hold modulation)

• Random (random modulation)

• Depth — Lets you adjust the amount of modulation applied to the Formant setting.

Parameter Description
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AIR Vintage Filter (RTAS)

You can use the Vintage Filter effect to apply a modulating, resonant filter to the audio 
signal. You can experiment with filter sweeps or give your sounds a large, resonant sound.

The following table lists the AIR Vintage Filter plug-in parameters:

Envelope Modulates the Formant setting by using an envelope follower. This allows you to accentuate and 
enhance signal peaks in rhythmic material.

• Thresh — Sets the amplitude threshold at which the Formant setting begins to be modulated 
by the envelope follower.

• Attack — Sets the time (10.0 ms to 10 seconds) it takes to respond to increases in the audio 
signal level.

• Release — Sets the time (10.0 ms to 10 seconds) it takes to recover after the signal level 
falls.

Mix Lets you balance the amount of dry signal with the amount of wet (processed) signal. At 50%, 
the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 
100% it is all wet.

Parameter Description

Parameter Description

Cutoff Lets you adjust the Cutoff frequency (20.0 Hz to 20.0 kHz) of the filter.

Resonance Lets you adjust the amount filter Resonance (0–100%). The filter can go into self-oscillation at 
high values creating a sine wave-like overtone at the Cutoff frequency.

Fat Lets you adjust the amount of overdrive in the resonant peak. At lower settings the signal gets 
quieter at high resonance settings for clean distortion. At higher settings the signal is over-driven 
at high resonance settings.
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Envelope Provides an envelope follower for controlling the Cutoff frequency, which allows you to control 
the envelope’s shape and depth of modulation.

• Attack — Sets the time (10.0 ms to 10 seconds) it takes to respond to increases in the audio 
signal level.

• Release — Sets the time (10.0 ms to 10 seconds) it takes to recover after the signal level 
falls.

• Depth — Determines how much the envelope follower affects the Cutoff frequency.

• At 0%, the envelope follower has no effect on the Cutoff frequency. 

• At +100%, the Attack ramps up to the Cutoff frequency setting, and the Release starts from 
the Cutoff frequency setting and ramps down. 

• At –100%, the Attack starts from the Cutoff frequency setting and ramps down, and the 
Release ramps up to the Cutoff frequency setting. 

LFO Provides a sinusoidal Low Frequency Oscillator (LFO) for modulating the filter cutoff 
frequency, which allows you to control the rate, depth and synchronization of the modulation.

• Sync — Turns on and off the synchronization between the LFO and the sequence tempo.

• Rate — Increases or decreases the frequency (0.01–100.0 Hz) of the LFO. Lower settings 
are slower and higher settings are faster. When you enable Sync, the Rate knob changes from 
counting in milliseconds to rhythmic values.

• Depth — Increases or decreases the amount of modulation (0–100%) of the Cutoff 
frequency by the LFO. Lower settings create a slight vibrato (with the rate set high) and 
higher settings create a wide sweep of the Cutoff frequency range.

Mode Select one of the following options for the type of filter:

• LP24 — Provides a low pass filter with a 24 dB cutoff.

• LP18 — Provides a low pass filter with a 18 dB cutoff.

• LP12 — Provides a low pass filter with a 12 dB cutoff.

• BP — Provides a band pass filter.

• HP — Provides a high pass filter.

Output Lets you lower the Output level from 0.0 dB to –INF dB.

Parameter Description
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International Character Support

Avid Media Composer v5.5 and later, Avid Symphony v5.5 and later, and Avid NewsCutter 
v9.5 and later support Unicode characters for file import and output operations. This allows 
you to import and export files and bins in any language or character set.

If you work in an Interplay environment, you must set all systems — including your 
Interplay servers — to the same locale. This limitation applies to all earlier versions of Avid 
editing applications as well.

If you import a media file or bin containing characters from a locale different from the one 
on your system, you might see nonstandard characters in the file or bin name. For example, 
if you import a bin or master clip with Japanese characters to a system using the English 
locale, the file name might contain question marks (?) in place of the Japanese characters. 
You can continue to work with the bin or clip, but Avid recommends that you first rename it. 
Alternatively, you can close your Avid editing application, change your locale, and then 
restart your system. This restriction also applies when opening Marquee with a user name 
that includes characters from a locale that is different from the locale for your operating 
system.

If your Avid editing application uses a localized user interface (UI), the UI matches the 
locale for your operating system. You can override the localized UI and use an English UI by 
doing the following:

1. Close your Avid editing application.

2. In your installation directory, navigate to the following location: Avid\[Avid editing 
application]\SupportingFiles\International\xml\.

3. Rename English_override.xml to override.xml.

4. Restart your Avid editing application.

AMA Linking with Multichannel Audio

You can use the AMA Settings dialog box to define the audio track formats for the audio 
channels in your linked media, up to a maximum of 16 audio channels for the clips in your 
bins. This allows you to specify which source channels are treated as mono or multichannel 
audio tracks in your project, rather than having to modify the clips in your bin after you link 
to the AMA media.

The mappings affect all media clips created when you link to your source media. If you want 
to use different mixes for different master clips or different projects, create a custom AMA 
Settings template for each separate type of mix and then create your linked master clips.
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Each stereo track requires two channels, but you can mix mono and stereo input channels for 
your linking operation as long as you do not exceed the maximum of 16 audio channels for 
each master clip.

To specify the multichannel audio mix for linked AMA clips:

1. In the Project window, click the Settings tab.

2. Double-click AMA.

The AMA Settings dialog box appears.

For information about the AMA Settings, see “AMA Settings” in the Help.

3. Click the Link Options tab.

The Link Options tab lists any multichannel audio mappings in the current AMA 
Settings template.

4. Click Edit. 

The Set Multichannel Audio dialog box opens.
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5. Click the format buttons to select one of the following audio track formats for each pair 
of source channels:

You must map source audio channels in mono or stereo pairs. For example, you cannot 
map A1 to a mono track and A2 and A3 to a stereo track. Instead, map A1 and A2 to 
mono tracks, and A3 and A4 to a stereo track. If the source media does not have an 
audio channel on A2, the Avid editing application ignores the channel.

6. Click OK to close the Set Multichannel Audio dialog box, and then click OK to close 
the AMA Settings dialog box.

The Track Formats column in the bin Text view displays the format for all multichannel 
audio tracks in a master clip.

To save a custom map of linked audio channels as a settings template:

1. Click the Settings tab in the Project window.

The Settings list appears.

2. Click AMA.

3. Select Edit > Duplicate.

A duplicate setting appears in the Settings list.

4. Name the setting by doing the following:

a. Click the custom name column.

b. Type a name.

Button Track Format

Mono

Stereo
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c. Press Enter (Windows) or Return (Macintosh).

n The custom name column is the center column in the Project window. When you move the 
pointer over the custom name column, the pointer changes from a pointing finger to a text 
insertion bar.

You can select this new setting whenever you link clips with AMA.

Sony XDCAM/XDCAM EX Plug-in

For Beta, when you install the Avid editing application Beta software, all previous versions 
of AMA plug-ins will be removed, since the AMA plug-ins have been unbundled.

A folder has been provided to reinstall the new plug-ins.

The Sony XDCAM and XDCAM EX installer, PDZK_MA2 will automatically perform the 
following:

• Delete (if present) the old XDCAM and XDCAM EX plug-in, 
“MVP_MSP_SonyXDCAM.avx”.

• Install SonyXDCAM.avx, MVP_SONYXDCAMEX.avx, and 
MSP_SonyXDCAMEXMP4.avx plug-ins

If for some reason, you need to go back to a pre-Beta version of the Avid editing application 
(v5.0.x), be aware that the old Sony plug-in will reinstall MVP_MSP_SonyXDCAM.avx on 
your system. Two versions of the XDCAM plug-ins will reside on your system. When this 
occurs, the original “MVP_MSP_SonyXDCAM.avx” plug-in will install alongside the 
newer “SonyXDCAM.avx” plug-in.  As a result, you might experience problems if you 
previously imported files which are not supported by the original 
“MVP_MSP_SonyXDCAM.avx” plug-in into your project through Link to AMA using the 
newer “SonyXDCAM.avx” plug-in.

Workaround: If you need to reinstall an earlier version of the Avid editing application 
(v5.0.x), you should always uninstall the Sony PDZK-MA2 plug-ins prior to uninstalling, 
upgrading or performing a repair install of the Avid editing application, and you should 
always reinstall the Sony PDZK-MA2 plug-ins after reinstalling, upgrading, or performing a 
repair install of Avid.  The uninstall of the Sony PDZK-MA2 plug-in can be performed on a 
Windows system by rerunning the installer and choosing the remove option.  This can also 
be done on a Windows system using the “Add/Remove Programs” or “Programs and 
Features” option from the Control Panel window. On the Mac OS you will need to manually 
remove the plug-in from the AVX2_Plug-ins folder.  You can refer to the “PDZK-MA2 v1.0 
Install Guide For Mac.docx” or the “PDZK-MA2 v1.0 Install Guide For Windows.docx” for 
detailed instructions.
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FluidMorph Effect Source and Input Parameters
Source Menu

Using the AVC-I Codec Module

The following information applies if you have the Nitris DX with the AVC-I codec module 
installed. The codec module provides real-time encoding to the AVC-intra compression 
format, using the 10-bit high definition H.264 intra-frame codec. 

This module allows for real-time baseband capture with the Nitris DX and allows real-time 
performance for most rendering and mixdown operations.

When you start your Avid editing application, it detects the presence of the AVC-I codec 
module. It will use the module for capture, render and mixdown. If the module is not 
present, the editing application uses the software codec to perform these operations. 
Although, baseband capture of AVC-I is supported only with the hardware codec.

Resolution Specifications: AVC-Intra with AVC-I Codec Module

The following table provides AVC-Intra (with AVC-I Codec Module) specifications by 
project type.

Option Description

Still->Still Your Avid editing application takes snapshots of the first frame of outgoing 
video and the last frame of incoming video and creates an output that is a 
morph of the two images.

Stream->Stream Your application creates the output by morphing the two clips, frame by 
frame.

Stream->Still Your application creates the output by morphing each frame of the outgoing 
video with the last frame of incoming video.

Still->Stream Your application creates the output by morphing the first frame of the 
outgoing video with each frame of the incoming video.
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Searching for a Clip or Sequence with Text Find
Text Find allows you to enter text and search bins, Scripts and the Timeline for the 
information you enter. You can customize your search by selecting to only search the active 
bin or search all bins across a single project. Bins do not have to be open for the system to 
search in them. The Text find feature is included with your Avid editing application. 

PhraseFind (the phonetic find feature) is purchased as a separate option. Both Text find and 
PhraseFind can be used together or independently of each other.

For information about the phonetic search option, see “PhraseFind” in the Help. If you have 
not purchased PhraseFind and would like more information, click the PhraseFind button in 
the Find window, then click Info.

For a table of all the options available in the Find Window, see “Find Window Attributes” in 
the Help.

Project Edit Rate Resolution Name MB/Sec Raster Size

1080i 59.94 AVC-Intra 50 50MBit 1440x1080

AVC-Intra 100 100MBit 1920x1080

1080i 50 AVC-Intra 50 50MBit 1440x1080

AVC-Intra 100 100MBit 1920x1080

1080p 29.97 AVC-Intra 50 50MBit 1440x1080

AVC-Intra 100 100MBit 1920x1080

1080p 23.976 AVC-Intra 50 50MBit 1440x1080

AVC-Intra 100 100MBit 1920x1080

1080p 25 AVC-Intra 50 50MBit 1440x1080

AVC-Intra 100 100MBit 1920x1080

720p 59.94 AVC-Intra 50 50MBit 960x720

AVC-Intra 100 100MBit 1280x720

720p 50 AVC-Intra 50 50MBit 960x720

AVC-Intra 100 100MBit 1280x720
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Things You Should Know About Text Find

• You can continue to work, while the system indexes your project.

• The system creates a SearchData folder located in your Projects folder when you index 
text or phonetic searches. If you are working in an ISIS environment, the SearchData 
folder is located inside the Project client (computer name) folder.

• All tabs: Clips and Sequences, Script Text, and Timeline and Monitors tab apply to Text 
Find.

• The system does not search and find referenced clips in a sequence.

• If you make a change to a bin (or add a new clip to the bin), you must save the bin first 
in order for the system to find the changes.

• The system searches through all available columns in your bins including metadata 
columns, even if they are not visible in your current bin.

• The use of quotes in search queries has no affect on your results. 

• The following characters: @#$%^&*()=+[]\ are recognized by Text Find.

• If you want to refresh your results, save a bin.

• Before you filter to refine your results, you need to first perform a find, then the Filter 
columns are selectable.

To open a search window:

1. Press Ctrl+F (Windows) or Cmd+F (Macintosh), or select Edit > Find.

The Find window opens.
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n The Bin Index status at the bottom of the window indicates if the data files in your bins have 
been indexed. A full green display indicates that your files have been indexed and are ready 
to search. A partial green display indicates that the index is in process and if you perform a 
search, your results might not be complete.

2. Type a word or phrase that you are looking for in the text box.

3. Select to search in Clips and Sequences, Script Text, or Timeline and Monitors.

4. If you select Clips and Sequences, then select from the menu:

5. If you select Script Text, then select from the following:

6. A script text search displays all matches in the script, to find the next occurrence of your 
text criteria, press Ctrl+G (Windows) or Cmd+G (Macintosh) in your script.

7. If you select Current Script, you can select “Whole words only” to search for only that 
word. 

8. Select Ignore Case if you want the system to search for the text regardless if it is upper 
or lower case characters.

9. If you select Timeline and Monitors, then select from the following:

Bins in Project
Bins and Scripts in Project

The system searches for the text criteria in all the 
bins/scripts within the project regardless if the 
bin/script is currently opened.

Current Bin The system searches for the text criteria in the last 
active bin. The system then selects the first occurrence 
in the bin. Press Ctrl+G (Windows) or Cmd+G 
(Macintosh) to take you to the next occurrence

Scripts in Project The system searches for the text criteria in all the 
scripts within the project regardless if the script is 
currently opened.

Current Script The system searches for the text criteria in the last 
active script.

Locators The system searches for clips in the Timeline that contain 
the locator text. The blue position bar jumps to the locator 
position on the clip and displays the locator information in 
the Source/Record monitor.
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10. If you would like to open the clip(s) in a Source monitor when you double-click a clip in 
the Results window, then select Load into monitor.

n Loading the clip in the Source monitor is dependant on the option you have chosen for 
“Double-click loads object in” in your Bin Settings.

11. With your text criteria entered, click Find or press Enter.

A Cancel button appears and the system informs you that it is finding your text criteria.

The results appear in the Results window. If you select Current Bin, the clips are 
selected in the bin and do not display in the Results window. The system displays the 
total number of items found after your search.

n To select the next occurrence in your bin, press Ctrl+G (Windows) or Cmd+G (Macintosh).

12. (Option) To refine the number of results, you can enter additional criteria in the filters. 
Select a specific column from the Filter menu that you would like to search in, then 
enter additional text relating to that column. 

n Click the “+” button to add additional filters. Click the “-” button to remove filters. If the 
last filter appears, the “-” button removes the text, not the filter.

The filter menu populates after the initial search.

For information about filtering your results, see “The Results Window” in the Help.

Adjusting QuickTime Source Settings
You can change the dynamic range of a linked AMA QuickTime movie from 601/709 video 
range (16-235) to RGB range (0-255) or from RGB range (0-255) to 601/709 video range 
(16-235). This setting is only supported with QuickTime movies that were created with a 
non-Avid codec, including ProRes, H.264 and Animation.

When a QuickTime clip displays in the bin, the system displays the metadata columns of the 
clip’s color values. 

Clip Names The system searches for clips in the Timeline that contain 
the clip name. The blue position bar jumps to the head frame 
of the clip.

Timeline Text The system searches for clips in the Timeline that contain 
Timeline text based on what is displayed in the Clip Text 
pulldown menu. The blue position bar jumps to the head 
frame of the clip.
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To change the QuickTime source settings:

1. Link the QuickTime clip through the File > Link to AMA File option or to link to 
multiple QuickTime files, use the File > Link to AMA Volume(s) option.

See “The Avid Media Access (AMA) Workflow” and “Linking Media with AMA” in 
the Help for information on linking.

2. Right-click the QuickTime clip in the bin and select Set Source Settings.

n If your QuickTime movie was created with an Avid codec, the Set Source Settings option will 
not be available.

The Source Settings dialog box opens. The clip displays in the video area.

For information on settings in the Settings menu and how to apply a setting, see 
“Applying a QuickTime Source Setting” in the Help.

3. Drag the video slider to the frame you want to view.

The new frame displays and the histogram updates.

The histogram is a tool that helps you more precisely adjust Source Settings. For more 
information about the histogram, see 
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4. Set the appropriate options:

5. Click Apply.

The changes apply to your clip. You can continue to make additional changes. 

If the clip is in the Source viewer, the changes are reflected in the Source viewer and in 
the Client monitor (if you have one attached).

If you click Cancel after you click Apply, the Set Source Settings window closes with 
the changes you made.

6. Click OK to save your change and close the window.

The system updates the bin column metadata with the new parameters.

n If you make changes in the Source Settings window and then relink the clip through AMA 
again, you still keep all the parameters that you set. 

Option Description

Settings Default
Custom: User created in Avid.

Field Ordering Default
Progressive: The image is interpreted as a progressive image.
Interlaced - Odd (upper field first) ordered: Adjusts the clip so that 
the top field is played before the lower field.
Interlaced - Even (lower field first): Adjusts the clip so that the lower 
field is played before the top field.

GFX/Video Level Do not modify levels: Leave as is
Expand video levels to graphic levels: Changes the dynamic range 
from an 601/709 video range (16-235) to RGB range (0-255).
Compress graphic levels to video levels: Changes the dynamic range 
from RGB (0-255) range to an 601/709 video range (16-235). This 
option is useful if you created a QuickTime movie with graphic 
levels in AfterEffects and then brought the clip into an Avid editing 
application. 
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, 
Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product 
may only be used in accordance with the license agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents: 5,267,351; 5,355,450; 
5,396,594; 5,440,348; 5,528,310; 5,557,423; 5,577,190; 5,584,006;  5,724,605; 5,726,717; 5,745,637; 5,752,029; 5,754,851; 
5,812,216; 5,905,841; 5,930,445; 5,959,610, 6,057,829, 6,091,778, 6,105,083, 6,118,444, 6,141,691, 6,160,548, 6,201,531; 
6,269,195; 6,330,369; 6,336,093, 6,353,862, 6,404,435; 6,407,775, 6,426,778; 6,477,271, 6,489,969; 6,512,522; 6,546,190; 
6,552,731, 6,553,142; 6,570,624; 6,571,255, 6,583,824; 6,618,547; ,665,450; 6,678,461; 6,687,407; 6,704,445; 6,728,682, 
6,747,705; 66,763,134,6,766,063; 6,791,556; 6,810,157, 6,847,373; 6,871,003; 6,871,161, 6,901,211; 6,907,191; 6,928,187, 
7,043,058; 7,081,900; 7,103,231; 7,145,567; 7,266,241, 7,280,117; 7,403,561; 7,433,519; 7,441,193, 7,545,957; 7,671,871; 
7,684,096; 7,725,812; 7,729,423; and D515,095, D396,853. Other patents are pending.

Avid products or portions thereof are protected by one or more of the following European Patents: 0506870; 0635188; 
0674414; 0752174; 0811290; 0811292; 0811293; 0857293; 0976108; 0988756; 1050048; 1068734; 1111910; 1173850; 
1629675.  Other patents are pending.

This document is protected under copyright law. An authorized licensee of Avid Media Composer may reproduce this 
publication for the licensee’s own use in learning how to use the software. This document may not be reproduced or 
distributed, in whole or in part, for commercial purposes, such as selling copies of this document or providing support or 
educational services to others. This document is supplied as a guide for Avid Media Composer. Reasonable care has been 
taken in preparing the information it contains. However, this document may contain omissions, technical inaccuracies, or 
typographical errors. Avid Technology, Inc. does not accept responsibility of any kind for customers’ losses due to the use of 
this document. Product specifications are subject to change without notice.

Copyright © 2011 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING 
THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY 
PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE 
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. 
THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose 
is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of 
the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any 
advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon 
Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, 
DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF 
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 
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Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph 
are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such 
distribution and use acknowledge that the software was developed by the University of California, Berkeley. The name of the 
University may not be used to endorse or promote products derived from this software without specific prior written 
permission. THIS SOFTWARE IS PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that 
the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to 
distribution of the software without specific, written prior permission. Daniel Dardailler makes no representations about the 
suitability of this software for any purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this 
entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all 
copies of the supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other 
trademarks are the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, 
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the 
exclusive property of Nexidia Inc. or its licensors.  The Nexidia products and services described in these materials may be 
covered by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 
and/or other patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be 
liable for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or 
operation of reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, 
special or consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s 
products or the software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates 
has been advised, knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”
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“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use 
of this software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players 
and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample 
Source Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid 
products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third 
Party Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in 
connection with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, 
Assistant Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, 
Avid DNxcel, Avid DNxHD, Avid DS Assist Station, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, 
Avid Mojo, Avid Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, 
Axiom, Beat Detective, Beauty Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Boom, Bruno, C|24, 
CaptureManager, ChromaCurve, ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, 
Command|24, Command|8, Conectiv, Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, Dazzle, 
Dazzle Digital Video Creator, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 003, DigiBase, DigiDelivery, 
Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, 
Digital Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, DPP-1, D-Show, 
DSP Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, Expander, 
ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, 
FXDeko, HD Core, HD Process, HDPack, Home-to-Hollywood, HYBRID, HyperControl, HyperSPACE, HyperSPACE HDCAM, 
iKnowledge, Image Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, 
Intelligent Content Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, 
Intelli-sat Broadcasting Recording Manager, InterFX, Interplay, inTONE, Intraframe, iS Expander, ISIS, IsoSync, iS9, iS18, 
iS23, iS36, ISIS, IsoSync, KeyRig, KeyStudio, LaunchPad, LeaderPlus, LFX, Lightning, Link & Sync, ListSync, LKT-200, Lo-Fi, 
Luna, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, MassivePack, 
Massive Pack Pro, M-Audio, M-Audio Micro, Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMatch, MediaMix, 
Media Reader, Media Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, MetaSync, MicroTrack, MIDI I/O, Midiman, 
Mix Rack, MixLab, Moviebox, Moviestar, MultiShell, NaturalMatch, NewsCutter, NewsView, Nitris, NL3D, NLP, Nova, 
NRV-10 interFX, NSDOS, NSWIN, Octane, OMF, OMF Interchange, OMM, OnDVD, Open Media Framework, 
Open Media Management, Ozone, Ozonic, Painterly Effects, Palladium, Personal Q, PET, Pinnacle, Pinnacle DistanTV, 
Pinnacle GenieBox, Pinnacle HomeMusic, Pinnacle MediaSuite, Pinnacle Mobile Media, Pinnacle Scorefitter, Pinnacle Studio, 

http://www.apache.org/
http://jcifs.samba.org/
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Pinnacle Studio MovieBoard, Pinnacle Systems, Pinnacle VideoSpin, Podcast Factory, PowerSwap, PRE, ProControl, 
ProEncode, Profiler, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, Pro Tools, QuickPunch, QuietDrive, 
Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket Surfer, 
Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, Scorefitter, ScriptSync, 
SecureProductionEnvironment, Serv|LT, Serv|GT, Session, Shape-to-Shape, ShuttleCase, Sibelius, SIDON, SimulPlay, 
SimulRecord, Slightly Rude Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, Solaris, SoundReplacer, SPACE, 
SPACEShift, SpectraGraph, SpectraMatte, SteadyGlide, Streamfactory, Streamgenie, StreamRAID, Strike, Structure, 
Studiophile, SubCap, Sundance Digital, Sundance, SurroundScope, Symphony, SYNC HD, Synchronic, SynchroScope, 
SYNC I/O, Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, Titansync, Titan, TL Aggro, TL AutoPan, TL Drum Rehab, 
TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, tools for storytellers, Torq, 
Torq Xponent, Transfuser, Transit, TransJammer, Trigger Finger, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, 
Video the Web Way, VideoRAID, VideoSPACE, VideoSpin, VTEM, Work-N-Play, Xdeck, X-Form, Xmon, XPAND!, Xponent, 
X-Session, and X-Session Pro are either registered trademarks or trademarks of Avid Technology, Inc. in the United States 
and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other 
countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other 
countries. All other trademarks contained herein are the property of their respective owners. 

Footage
Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com, Carol Amore, Executive Producer.
"The Big Swell" — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.

What’s New • 0130-0130-30397-02 • February 2011

http://www.wildlifeworlds.com

	New Features
	Modifying Transition Effects in the Timeline
	Using Avid Artist Series Controllers
	Installing EuControl Software
	Configuring Avid Artist Series Controller Settings
	Configuring Ethernet Connections (Macintosh)
	Configuring EuControl Settings
	Artist Series Controller Button Mappings
	Customizing Avid Artist Series Controls
	Moving Through Footage with Artist Series Controllers
	Automation Gain and Pan on Artist Series Controllers
	Recording Automation Gain and Pan with Artist Series Controllers
	Using the Latch Mode Feature on Artist Series Controllers
	Using the Artist Series Controller for Editing Media

	Using Mbox Family Audio Devices
	Configuring the Mbox Device
	Setting Up the Mbox Pro for Passthrough Monitoring (Windows Only)

	AJA Io Express Support
	Capturing OHCI (Host 1394)

	Avid Pro Tools|HD Native Hardware Configuration for Avid Editing Systems
	Configuring the ASIO Driver (Windows)
	Configuring the CoreAudio Driver (Macintosh)

	Importing with Multichannel Audio
	Suggested Uses for Locators
	Mapping Audio Tracks to Output Channels
	AIR Avid Audio Plug-Ins
	AIR Chorus (RTAS)
	AIR Distortion (RTAS)
	AIR Dynamic Delay (RTAS)
	AIR Enhancer (RTAS)
	AIR Ensemble (RTAS)
	AIR Filter Gate (RTAS)
	AIR Flanger (RTAS)
	AIR Frequency Shifter (RTAS)
	AIR Fuzz-Wah (RTAS)
	AIR Kill EQ (RTAS)
	AIR Lo Fi (RTAS)
	AIR Multi-Chorus (RTAS)
	AIR Multi-Delay (RTAS)
	AIR Non-Linear Reverb (RTAS)
	AIR Phaser (RTAS)
	AIR Reverb (RTAS)
	AIR Spring Reverb (RTAS)
	AIR Stereo Width (RTAS)
	AIR Talkbox (RTAS)
	AIR Vintage Filter (RTAS)

	International Character Support
	AMA Linking with Multichannel Audio
	Sony XDCAM/XDCAM EX Plug-in
	FluidMorph Effect Source and Input Parameters
	Using the AVC-I Codec Module
	Resolution Specifications: AVC-Intra with AVC-I Codec Module

	Searching for a Clip or Sequence with Text Find
	Adjusting QuickTime Source Settings

